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About this guide
This guide describes how to use HPE NonStop SQL/MX Database Manager to monitor and
manage SQL/MX databases.

Supported release version updates (RVUs)
This publication supports L16.05 and all subsequent L-series RVUs unless mentioned otherwise.

Intended audience
This guide is intended for those who perform standard database administration tasks. It provides
basic concepts and task information to get you started quickly and easily.

New and changed information
Changes made to the 69119-006 edition

• Updated MXDM 3.4 features in the sections “Overview” (page 11) and “MXDM features and
functionalities” (page 11).

• Updated the following sections:

“Supported SQL/MX versions” (page 14).◦
◦ “Prerequisites” (page 15)

◦ “Installing the 32-bit version of MXDM” (page 15)

◦ “Installing the 64-bit version of MXDM” (page 16)

◦ “Starting up MXDM” (page 17)

◦ “Adding a system” (page 17)

◦ “Saving and importing system definitions” (page 43)

• Added LoginTimeOut, ConnectionTimeOut, and QueryTimeOut descriptions in section
“Setting the timeout in MXDM” (page 23).

• Added the following in “Managing database objects” (page 45):

“Searching database objects” (page 45)◦
◦ “Granting privileges on a table” (page 77)

◦ “Revoking privileges on a table” (page 79)

◦ “Managing views” (page 88)

◦ “Granting privileges on a procedure” (page 99)

◦ “Revoking privileges on a procedure” (page 100)

◦ “Managing SQL/MP aliases” (page 101)

◦ “Managing sequence generators” (page 104)

◦ “Managing triggers” (page 111)

• Added MXCS Services information in Table 26 (page 128).

Supported release version updates (RVUs) 7



Changes made to the 69119-005R edition
Updated Hewlett Packard Enterprise references.

Changes made to the 691119-005 edition (May 2015)
This manual includes update to chapter “Managing database objects” (page 45) to provide
information on managing catalogs, managing schemas, managing indexes and managing tables.

Related documentation
This manual is part of the HPE NonStop SQL/MX library of manuals.

NonStop SQL/MX customer library
The following are the manuals in the SQL/MX customer library:

• Introductory guides

Describes differences between NonStop SQL/MP and NonStop SQL/MX
databases.

SQL/MXComparisonGuide for
SQL/MP Users

Describes basic techniques for using SQL in the SQL/MX conversational
interface (MXCI). Includes information about installing the sample database.

SQL/MX Quick Start Guide

• Installation guides

Describes how to plan for, install, create, and upgrade a SQL/MX database.SQL/MX Installation and
Upgrade Guide

Describes how to manage a SQL/MX database.SQL/MX Management Manual

Describes how to install NSM/web and troubleshoot NSM/web installations.NSM/web Installation Guide

• Reference manuals

Describes the syntax of SQL/MX statements, MXCI commands, functions, and
other SQL/MX language elements.

SQL/MX Reference Manual

Describes SQL/MX messages.SQL/MX Messages Manual

Defines SQL/MX terminology.SQL/MX Glossary

• Connectivity manuals

Describes how to install and manage SQL/MX Connectivity Service (MXCS),
which enables ODBC and other connectivity APIs to use NonStop SQL/MX.

SQL/MX Connectivity Service
Manual

Describes the SQL/MX Administrative Command Library (MACL) available
with the SQL/MX conversational interface (MXCI).

SQL/MX Connectivity Service
Administrative Command
Reference

Describes how to install and configure HPE NonStop ODBC/MX for Microsoft
Windows, which enables applications developed with ODBC API to use
NonStop SQL/MX.

ODBC/MX Driver for Windows

Describes how to use SQL/MX Remote Conversational Interface to run the
RMXCI commands, and SQL statements interactively or from script files.

SQL/MX Remote
Conversational Interface
(RMXCI) Guide

Describes how to use the NonStop SQL/MX Database Manager (MXDM) to
monitor and manage the SQL/MX database.

HPE NonStop MXDM User
Guide
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Describes the NonStop JDBC Type 2 Driver functionality, which allows Java
programmers to remotely develop applications deployed on client workstations
to access NonStop SQL/MX databases.

HPE NonStop JDBC Type 2
Driver Programmer's
Reference

Describes the NonStop JDBC Type 4 Driver functionality, which allows Java
programmers to remotely develop applications deployed on client workstations
to access NonStop SQL/MX databases.

HPE NonStop JDBC Type 4
Driver Programmer's
Reference

• Migration guides

Describes how to migrate databases and applications to NonStop SQL/MX,
and how to manage different versions of NonStop SQL/MX.

SQL/MX Database and
Application Migration Guide

Describes how to migrate NonStop SQL/MX, NonStop SQL/MP, Enscribe
databases and applications to HPE Integrity NonStop NS-series systems.

NonStop NS-Series Database
Migration Guide

• Data management guides

Describes the SQL/MX data structures and operations for data mining.SQL/MX Data Mining Guide

Describes how to produce formatted reports using data from an SQL/MX
database.

SQL/MX Report Writer Guide

Describes the features and functions of the DataLoader/MX product, a tool to
load SQL/MX databases.

DataLoader/MX Reference
Manual

• Application development guides

Describes how to embed SQL/MX statements in ANSI C and COBOL programs.SQL/MXProgrammingManual
for C and COBOL

Describes how to understand query execution plans and write optimal queries
for an SQL/MX database.

SQL/MX Query Guide

Describes how NonStop SQL/MX integrates transactional queuing and
publish/subscribe services into its database infrastructure.

SQL/MX Queuing and
Publish/Subscribe Services

Describes how to use stored procedures that are written in Java within NonStop
SQL/MX.

SQL/MX Guide to Stored
Procedures in Java

• Online help

Contents and reference entries from the SQL/MX Database Manager User
Guide.

SQL/MX Database Manager
Help

Overview and reference entries from the SQL/MX Reference Manual.Reference Help

Individual messages grouped by source from the SQL/MX Messages Manual.Messages Help

Terms and definitions from the SQL/MX Glossary.Glossary Help

Context-sensitive help topics that describe how to use the NSM/web
management tool.

NSM/web Help

Context-sensitive help topics that describe how to use the Visual Query Planner
graphical user interface.

Visual Query Planner Help

The NSM/web, SQL/MX Database Manager, and Visual Query Planner help systems are
accessible from their respective applications. You can download the Reference, Messages, and
Glossary online help from Software Depot, at http://www.hpe.com/support/softwaredepot.

Related documentation 9
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For more information about downloading online help, see SQL/MX Release 3.3 Installation and
Upgrade Guide.

Publishing history
This guide supports HPE NonStop SQL/MX Release 3.4 until otherwise indicated by its
replacement publication. The publication date and part number indicate the current edition of the
document.

Publication DateProduct VersionPart Number

February 2015HPE NonStop SQL/MX Release 3.3691119-004

May 2015HPE NonStop SQL/MX Release 3.3691119-005

November 2015HPE NonStop SQL/MX Release 3.3691119-005R

June 2016HPE NonStop SQL/MX Release 3.4691119-006

Change bar notation
Change bars are used to indicate substantive differences between this manual and its preceding
version. Change bars are vertical rules placed in the right margin of changed portions of text,
figures, tables, examples, and so on. Change bars highlight new or revised information. For
example:
The message types specified in the REPORT clause are different in the COBOL85 environment
and the Common Run-Time Environment (CRE).
The CRE has many new message types and some new message type codes for old message
types. In the CRE, the message type SYSTEM includes all messages except LOGICAL-CLOSE
and LOGICAL-OPEN.
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1 Introduction to MXDM
This chapter discusses the following topics:

• “Overview” (page 11)

• “MXDM features and functionalities” (page 11)

• “MXDM functional flow” (page 13)

Overview
MXDM is an integrated graphical user interface (GUI) client that enables you to connect to and
manage multiple NonStop SQL/MX databases. Using MXDM, you can manage database and
SQL/MX Connectivity Services (MXCS) objects, execute DDL and DML statements, view query
results, and assign access permissions to system users. You can graphically create, alter, rename,
and drop database objects and modify the user privileges on them. You can also launch the HPE
NonStop SQL/MX Remote Conversational Interface (RMXCI) from MXDM. RMXCI is used to
perform administrative and database management tasks by running SQL statements interactively
or from script files.
For more information on RMXCI, see HPE NonStop SQL/MX Remote Conversational Interface
(RMXCI) Guide.
Related Topics
“MXDM features and functionalities” (page 11)

MXDM features and functionalities
Database and MXCS objects enable you to perform the following actions:

• Search for specific database objects in all catalogs and schemas on the connected systems.

• Browse database objects and view the tables, indexes, views, procedures, SQL/MP aliases,
triggers, and sequence generators in each schema. You can also view details of individual
SQL/MX objects.

• Browse MXCS objects. On a managed system, you can view the MXCS services, data
sources, MXCS servers, and MXCS user permissions.

• Manage database objects.

You can create and drop database objects such as catalogs, schemas, tables, indexes,
triggers, views, SQL/MP Aliases and sequences. You can alter tables, indexes, views,

◦

SQL/MP Alias and sequences, enable and disable triggers, register and unregister
catalogs, and create a new table based on another table. You can also rename tables,
indexes, views and sequences.

◦ View a summary of groups of objects, such as, schemas in a catalog, tables in a schema,
indexes on a table, and so on.

◦ View information related to the size of the schema.

◦ View information about the partitions of a table or an index, such as the physical location,
size of extents and maximum partition size.

◦ Copy various tabular data such as list of catalogs, schemas, data sources, object
properties, servers, or services to spreadsheets or files.

◦ Use the SHOW DDL tool to generate and save the Data Definition Language (DDL)
script for a group of SQL/MX objects.

Overview 11



◦ View information related to table profiles and statistics.

◦ Launch OSM Event Viewer to view EMS logs.

• Execute queries and view data results using SQL Whiteboard .

Execute DDL and Data Manipulation Language (DML) statements.◦
◦ Persist queries across sessions for reuse.

◦ Copy query results to a spreadsheet.

◦ Highlight a portion of an SQL statement and execute it (syntax highlighting).

◦ Cancel an executing query.

◦ Open and save query text to a file.

◦ Use parameters in queries.

• Perform the following actions using MXDM Framework :

Manage multiple SQL/MX databases using a single instance of MXDM.◦
◦ Save the connection definition when you connect to a system the first time, and retrieve

the definition automatically during subsequent attempts to connect to that system.

◦ Access tools using menu and tool bar options.

◦ Customize the elements displayed in the UI.

◦ Copy grid contents to a spreadsheet, clipboard, browser or a file.

◦ Launch RMXCI.

• Data source and connectivity management enables users with the operator permission, to
perform the following:

◦ Add information related to environmental variables, such as, Control Query Defaults
(CQDs), DEFINEs and SETs, and Control Table Statements.

◦ Create, edit, copy, or delete data sources.

◦ Start and stop data sources.

◦ Stop server processes.

◦ Start and stop MXCS services.

◦ View user permissions.

◦ Associate a data source with one or more services.

NOTE: Only SUPER.SUPER user can assign and change user permissions.

Related Topic
“Obtaining version and build information” (page 37)
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MXDM functional flow
The functional model within which MXDM operates includes the following components on the
client workstation:

• MXDM

• Windows ODBC/MX driver
On the NonStop system, you must install the required MXCS objects and create those database
objects that you want to manage using MXDM. Figure 1 (page 13) shows the MXDM functional
flow.

Figure 1 MXDM functional flow

The following is the sequence of events involved in establishing the connection between MXDM
and the server components, and in managing the objects:
1. MXDM sends a connection request to the MXCS using the Windows ODBC/MX driver.

MXDM specifies an IP address or the NonStop server Domain Naming Service (DNS) name
and port number that is defined when the Association server started up.

2. The ODBC/MX driver accesses an MXCS Association server on the NonStop system.
3. The Association server associates the client application with an available MXCS server for

the data source.
4. MXDM sends a connection request to the MXCS server that was assigned by the Association

server. After the user information is validated, a connection between MXDM and the SQL/MX
database is established.

Subsequently, you can view and administer the database and MXCS objects on the system. You
can view the DDL statements for the database objects in MXDM. You can use these statements
to create the database objects using mxci.
For more information, see HPE NonStop SQL/MX Release 3.4 Connectivity Services Manual.

MXDM functional flow 13



2 Installing and uninstalling MXDM
This chapter discusses the following topics:

• “Supported SQL/MX versions” (page 14)

• “Contents of the installation package” (page 14)

• “Prerequisites” (page 15)

• “Installing MXDM” (page 15)

• “Uninstalling MXDM” (page 16)

Supported SQL/MX versions
The MXDM client can connect to systems running SQL/MX Release 3.4, 3.3, or 3.2.1. The
minimum supported metadata schema version is 3200 and schemas with version 1200, 3000,
and 3100 are not supported.

• If you connect to SQL/MX 3.4 through MXDM 3.4, MXDM 3.4 and earlier version features
are displayed.

• If you connect to SQL/MX 3.3 through MXDM 3.4, only MXDM release 3.3 and 3.2.1 features
are displayed.

• If you connect to SQL/MX 3.2.1 through MXDM 3.4, only MXDM release 3.2.1 features are
displayed.

NOTE: SQL/MX 3.2.1 is not available on L-series.
Windows ODBC/MX 3.4 driver is interoperable with MXCS versions 3.3 and 3.4. Therefore,
MXDM 3.4 version can connect to both SQL/MX 3.3 and 3.4 versions concurrently.

Contents of the installation package
MXDM is available in 32-bit and 64-bit versions. You can install the 32-bit version of MXDM on
a 32-bit system. You can install either a 32-bit or a 64-bit version of MXDM on a 64-bit system.
The installer is available at $SYSTEM.ZMXODBC.
The MXDM32EX file includes the required contents of the 32-bit version of MXDM. The MXDM64EX
file includes the required contents of the 64-bit version of MXDM.
For information on the location of Windows ODBC/MX driver installation package, see HPE
NonStop ODBC/MX Client Drivers User Guide for SQL/MX Release 3.4.
MXDM32EX.zip contains the following files:

• setup.exe

• MXDMInstaller.msi

MXDM64EX.zip contains the following files:

• setup.exe

• MXDMInstaller-x64.msi

NOTE: MXDM requires .NET 3.5 runtime. If .NET 3.5 runtime is not available on your system,
running setup.exe automatically detects and installs the .NET 3.5 runtime.
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Prerequisites
The Windows client workstation must meet the following minimum requirements:

• At least 512 MB memory

• At least 15 MB disk space for installation and 64 MB free space

• Microsoft Windows XP, 32-bit or 64-bit Microsoft Windows Vista, or 32-bit or 64-bit Microsoft
Windows 7

• Microsoft .NET Framework 3.5

NOTE: MXDM requires .NET 3.5 runtime. If .NET 3.5 runtime is not available on your
system, running setup.exe automatically detects and installs the .NET 3.5 runtime.

• To connect to a server running SQL/MX 3.4, Windows ODBC/MX 3.4 must be installed on
the client.

• To connect to a server running SQL/MX 3.3, Windows ODBC/MX 3.4 or 3.3 must be installed
on the client.

• To connect to a server running SQL/MX 3.2.1, Windows ODBC/MX 3.4, 3.3, or 3.2 must be
installed on the client.

NOTE: SQL/MX 3.2.1 is not available on L-series.

NOTE: If you want to use RMXCI, you must install RMXCI available at $SYSTEM.ZMXODBC.
The t0774zip file includes the required contents of RMXCI. RMXCI requires JDBC T4 to be
installed on the client.

Installing MXDM
This section discusses the following topics:

• “Installing the 32-bit version of MXDM” (page 15)

• “Installing the 64-bit version of MXDM” (page 16)

NOTE: If you are installing MXDM on Microsoft Windows Vista, and you are not logged on as
an administrator, you must install the files in alternate location, such as C:\user\your logon
name\NonStop SQLMX Database Manager. Microsoft Windows Vista allows only
administrators to install files in the C:\Program Files folder.

Installing the 32-bit version of MXDM
To install the 32-bit version of MXDM:
1. Save the MXDM32EX file on your Windows system, and rename the file to MXDM32EX.zip.
2. Extract the contents of the MXDM32EX.zip file into a temporary folder, such as C:\temp.
3. Double-click setup.exe or MXDMInstaller.msi to launch the NonStop SQL/MX Database

Manager Installer program.
4. Follow the instructions in the Installer program and complete the installation.

On a 64-bit system, the installer installs the application at C:\Program Files (x86)\
Hewlett-Packard\NonStop SQLMX Database Manager, unless you specify a different
location.
On a 32-bit system, the installer installs the application at C:\Program Files\
Hewlett-Packard\NonStop SQLMX Database Manager, unless you specify a different
location.
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Installing the 64-bit version of MXDM
To install the 64-bit version of MXDM:
1. Save the MXDM64EX file on your Windows system, and rename the file to MXDM64EX.zip.
2. Extract the contents of the MXDM64EX.zip file into a temporary folder, such as C:\temp.
3. Double-click setup.exe or MXDMInstaller-x64.msi to launch the NonStop SQL/MX

Database Manager Installer program.
4. Follow the instructions in the Installer program and complete the installation.

The installer installs the application at: C:\Program Files\Hewlett-Packard\NonStop
SQLMX Database Manager\ directory unless you specify an alternate directory.

NOTE: The 64-bit version of MXDM can run only if the 64-bit version of the Windows
ODBC driver is installed on the client.

Uninstalling MXDM
To uninstall the 32-bit version of MXDM, select Start —> All Programs→NonStop SQLMX
Database Manager→Uninstall NonStop SQLMX Database Manager. You can also uninstall
MXDM using the Add and Remove Programs option in the Control Panel.
To uninstall the 64-bit version of MXDM, select Start —> All Programs→NonStop SQLMX
Database Manager 64-bit→Uninstall NonStop SQLMX Database Manager. You can also
uninstall MXDM using the Add and Remove Programs option in the Control Panel.
Before uninstalling MXDM, you must consider the following:

• You do not have to uninstall the MXDM client before installing a newer version of MXDM.

• Uninstalling does not remove favorites or system definitions.
Related Topics
“Obtaining version and build information” (page 37)
“Saving and importing system definitions” (page 43)
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3 Managing MXDM system objects
This chapter discusses the following topics:

• “Starting up MXDM” (page 17)

• “Adding a system” (page 17)

• “Connecting to a system” (page 19)

• “Disconnecting from a system” (page 20)

• “Using the Systems Tool” (page 20)

• “Editing a system definition” (page 22)

• “Copying a system definition” (page 22)

• “Removing a system” (page 23)

• “Testing a system definition” (page 23)

• “Setting the timeout in MXDM” (page 23)

• “Exiting MXDM” (page 25)

Starting up MXDM
To start up the 32-bit version of MXDM, complete the following steps:
1. Launch MXDM in one of the following ways:

• Double-click the NonStop SQLMX Database Manager icon on your desktop.

• Select Start —> All Programs→NonStop SQLMX Database Manager→NonStop
SQLMX Database Manager.

NOTE: The 32-bit version of MXDM can run only if the 32-bit version of the Windows
ODBC driver is installed on the client.

2. Perform the steps described in “Adding a system” (page 17).
To start up the 64-bit version of MXDM, complete the following steps:
1. Launch MXDM in one of the following ways:

• Double-click the NonStop SQLMX Database Manager 64–bit icon on your desktop.

• Select Start —> All Programs→NonStop SQLMX Database Manager
64-bit→NonStop SQLMX Database Manager.

NOTE: The 64-bit version of MXDM can run only if the 64-bit version of the Windows
ODBC driver is installed on the client.

2. Perform the steps described in “Adding a system” (page 17).

Adding a system
Using MXDM, you must add a system definition for the NonStop system on which you want to
manage the database and MXCS objects. Subsequently, you can connect to the system and
manage the objects. You can also use the Save Persistence option to save the system definition.
During subsequent attempts to connect to that system, the saved system definition is automatically
retrieved.
To add a new system definition:
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1. Open the Add System dialog in one of the following ways:
• In the navigation tree pane, right-click the My Systems folder, and select Add.

• Select Tools→Systems Tool, and click Add.
The Add System dialog appears.
Figure 2 (page 18) shows the Add System dialog.

Figure 2 Add System dialog

2. Enter the SQL/MX database connection details.
a. In the System Name field, enter a unique name to identify the system. The name can

include letters, numerals, the underscore character, and can be up to 32 characters.
For example, NSK_Test_Sys.

b. Enter the User Name and Password.
c. In the Data Source field, enter the data source name or select an existing data source

from the drop-down.
If an existing data source is selected, the remaining fields are automatically populated
with the settings of the selected data source.

d. In the Host field, enter the host name or IP address.
e. In the Port Number field, enter the port number on which the MXCS Association Server

is listening.
f. In the Default Catalog field, enter the default catalog name.
g. In the Default Schema field, enter the default schema name.
h. Select the required ODBC/MX driver.

3. Click Add.
The system definition is added. After the system is added, the system name is displayed in
the navigation tree pane, under the My Systems folder.

NOTE: After a system is added, the system definition persists from session to session
unless you remove it.
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Related Topics
“Connecting to a system” (page 19)
Terms
system definition

Connecting to a system
After adding a system definition, you can connect to the NonStop system. To connect:
1. Open the Connect / Edit System dialog box in one of the following ways:

• In the navigation tree pane, right-click the system name, and select Connect/Edit
System.

• In the navigation tree pane, click the system icon.

• Select Tools→Systems Tool, and double-click the system definition of the system to
which you want to connect. Alternatively, select the system definition, and click Edit.

TheConnect / Edit System dialog appears. The saved system definition appears by default.
You can modify the system definition, if required. For information on modifying the system
definition, see “Adding a system” (page 17).

2. In the Connect / Edit System dialog, enter the following details:
a. Optional: In the Data Source field, enter the client data source name. If you do not

specify a data source, or the name of the client data source does not match the name
of the server data source, the client connects to the default server data source,
TDM_Default_DataSource. If the client data source exists, the fields in the dialog
are loaded from the client data source fields.

NOTE: If the data source that you specify already exists on the local system, the
remaining fields are automatically loaded into this dialog.

b. Mandatory: In theUser Name field, enter the NonStop system user name. For example,
super.super.

c. Mandatory: In the Password field, enter the password of the NonStop system user.
d. Mandatory: In the Host field, enter the host name or the IP address of the NonStop

system.
e. Mandatory: In the Port Number field, enter the port number on which the MXCS

Association server is listening.

NOTE: You can retain the port number that you specified while adding the system
definition.

f. Optional: In the Default Catalog field, if the catalog is not specified in your operations,
enter the default catalog to be used while writing a query. If the catalog is not specified,
MXDM selects NONSTOP_SYSTEM_NSK. If this catalog does not exist in the server, you
can create it. You must be the super.super user to create this catalog.

g. Optional: In theDefault Schema field, enter the default schema to be used while writing
a query. If the schema is not specified, MXDM selects PUBLIC_ACCESS_SCHEMA. If
this schema does not exist in the database, you can create it. You must be the
super.super user to create this schema.

CAUTION: If the default catalog or schema name is a reserved word in SQL/MX,
such as USER, you must enclose the catalog or schema name within double quotes
(“USER”). Otherwise, the connection fails. For information on the list of reserved words,
see HPE NonStop SQL/MX Release 3.4 Reference Manual.

Connecting to a system 19



h. Mandatory: In the Driver field, select the version of the Windows ODBC/MX driver to
be used.

3. Click Connect.
MXDM attempts to establish a connection. If the connection cannot be established within
the specified timeout value, an error message appears. For information on changing the
timeout value, see “Setting the timeout in MXDM” (page 23).

NOTE: You can test whether the system definition is valid. In the left pane, click the system
name, and in the right pane, enter the details required to connect to the system, and click Test.
A dialog appears indicating whether the test is successful.

Related Topics
“Adding a system” (page 17)
“Disconnecting from a system” (page 20)
Terms
My Systems
Systems Tool
system definition

Disconnecting from a system
Disconnecting from a system closes all ODBC connections with that system. To disconnect from
a selected system:
1. Perform one of the following:

• In the navigation tree pane, right-click the connected system name, and select
Disconnect.

• In the navigation tree pane, click the system icon (see “MXDM interface” (page 26)),

and select Disconnect( ) on the MXDM toolbar.
• Select Tools→Systems Tool. Select the required system definition, and click

Disconnect.
The Confirm dialog box appears.

2. In the Confirm dialog, click Yes.
The system is disconnected.

After you have disconnected, the system icon and icon label change to reflect the disconnected
status. To disconnect from all systems, see “Exiting MXDM” (page 25).
Related Topics
“Using the Systems Tool” (page 20)
“Exiting MXDM” (page 25)
Terms
disconnect
Systems Tool

Using the Systems Tool
The Systems Tool feature enables you to define, add, edit, remove, duplicate, test, and connect
to an SQL/MX database.
To open Systems Tool, use one of the following methods:

• Click Systems Tool ( ) on the MXDM toolbar.

• From the menu bar, select Tools→Systems Tool.
The Systems Tool dialog appears.
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Figure 3 (page 21) shows the Systems Tool dialog.

Figure 3 Systems Tool dialog

Table 1 (page 21) describes the settings in the Systems Tool dialog.

Table 1 Systems Tool settings

DescriptionSetting

Displays the current state of the system definition (Connected or Disconnected).State

Displays the label that identifies this NonStop system. The system name can be up to 32
characters in length, and can consist of letters, numerals, and the underscore character.

System Name

Displays the name of the client data source. If you do not specify a data source, or the
name of the client data source does not match the name of the server data source, the

Data Source

client connects to the default server data source, TDM_Default_DataSource. If the
client data source exists, the value of the other fields in the dialog are loaded from the
client data source fields.

Displays the user name.User Name

Displays the DNS name or IP address of the target NonStop system.Host

Displays the ODBC/MX Association Server port number.Port Number

Displays the default catalog to be used when writing a query.Default Catalog

Displays the default schema to be used when writing a query.Default Schema

Displays the Windows ODBC/MX driver to be used.DriverString

CAUTION: If the default catalog or the default schema is a reserved word in SQL/MX (for
example, USER), you must enclose the catalog or schema name in double quotes (“USER”).
Otherwise, the connection fails. For information on reserved words, see HPE NonStop SQL/MX
Release 3.4 Reference Manual.

Table 2 (page 21) describes the Systems Tool options.

Table 2 Systems Tool options

DescriptionSetting

Enables you to test a selected system and displays the results in the Connection Test
Result dialog. Test is enabled when you select one or more systems.

Test

Enables you to launch the Connect / Edit System dialog with the current settings of the
selected system. Edit is enabled when you select one or more systems.

Edit

Enables you to launch the Add dialog.Add
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Table 2 Systems Tool options (continued)

DescriptionSetting

Enables you to launch theAdd System Like dialog with the current settings of the selected
system. You can use these settings to add a new system. Add Like is enabled when you
select only one system.

Add Like

Enables you to remove the selected system. The selected system can be connected or
disconnected. A Confirm dialog appears before the selected system is removed.

Remove

Enables you to disconnect a system. Disconnect is enabled when you select one or
more systems. A Confirm dialog appears before the selected systems are disconnected.

Disconnect

Enables you to close the Systems Tool.Close

Terms
system
data source
TDM_Default_DataSource

Editing a system definition
If you want to edit a system definition of a system, which is currently connected, you must first
disconnect from the system.
To edit a system definition:
1. Disconnect from the system. For information on how to disconnect, see “Disconnecting from

a system” (page 20).
2. Use one of the following methods to open the Connect / Edit System dialog:

• In the navigation tree pane, right-click the required system name, and select
Connect/Edit System

• Select Tools→Systems Tool. Select the required system definition, and click Edit
3. In the Connect / Edit System dialog, enter the data. For information on the fields, see

“Adding a system” (page 17).
4. Click Save to save the newly created system definition, or click Connect to connect to the

system.
Related Topics
“Disconnecting from a system” (page 20)

Copying a system definition
You can add a system by copying an existing system definition. To add a new system definition
using an existing system definition:
1. Open the Add System Like dialog using one of the following methods:

• In the navigation tree pane, right-click the name of the system whose system definition
you want to copy, and select Add Like.

• Select Tools→Systems Tool from the menu bar. Select the system definition that you
want to copy, and click Add Like.

The Add System Like dialog appears.
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2. In the Add System Like dialog:
a. Specify a new name in the System Name field.
b. Retain or modify the information specified in the fields of the selected system. For more

information on the fields, see “Adding a system” (page 17).

NOTE: If the data source that you specify already exists on the local system, the
remaining fields are automatically loaded into this dialog.

c. Click Add.
The new system definition is added.

Removing a system
To remove a system from MXDM:
1. Perform one of the following steps:

• In the navigation tree pane, right-click the system name, and select Remove.

• Select Tools→Systems Tool. Press Ctrl and select one or more systems that you
want to remove, and click Remove.

The Confirm dialog appears.
2. In the Confirm dialog box, click Yes.

The system definitions are removed.

Testing a system definition
To test the system definition:
1. Select the system in the navigation tree pane.

The Connect/Edit System fields appear in the right pane.
2. Enter the password.
3. Click Test.

The Connection Test Result dialog appears, indicating whether the system definition is
valid or not.

NOTE: Testing the system definition does not establish a connection to the system.

Terms
system definition
My Systems

Setting the timeout in MXDM
If you frequently receive connection timeout errors, you must increase the connection timeout
value. You can override the connection timeout in MXDM using the following rules:
• The default value for the ConnectionTimeOut is 7200 seconds (120 minutes).

• The range is an integer value from 0 to 2,147,483,647 seconds.

• Setting a value of 0 indicates no timeout.
MXDM also overrides login and query timeout set at client data source. By default, following are
the settings for:
• LoginTimeOut — 180 seconds.

• QueryTimeOut — No time out.
For more information on connection timeout, see “Timeout Settings” (page 25).
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To set the ConnectionTimeOut, LoginTimeOut, or QueryTimeout:
1. Perform the following:

• On the MXDM toolbar, click Options ( ).

• Select Tools→Options.
The Options dialog appears.

2. Select Framework in General.
3. In the right pane of the Options dialog, select the timeout from the Application Settings

pane.
4. Enter the number of seconds that you want to specify for the selected timeout.

Figure 4 (page 24) shows the Options dialog.

Figure 4 Options dialog

5. Click OK.
The new timeout value is set.

NOTE: MXDM loads these timeout values from the persistence file. So, for upgrade
scenarios, set the appropriate timeout values manually.

Related Topics
“Adjusting the display of an area” (page 31)
“Using the MXDM toolbar” (page 30)
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Timeout Settings
LoginTimeOut

It refers to the number of seconds MXDM waits for a login request to complete a successful
connection. If a login request exceeds the specified timeout value, an error message is
displayed.

ConnectionTimeOut
It refers to the number of seconds MXDM waits for a request to complete on a connection.
If a request exceeds the specified timeout value, an error message is displayed.

QueryTimeOut
It refers to the number of seconds MXDM waits for a query to execute. If a query execution
exceeds the specified timeout value, an error message is displayed.

Exiting MXDM
To disconnect from a single active session without exiting MXDM, right-click the system name
in the left pane and selectDisconnect. For more information, see “Disconnecting from a system”
(page 20).
To exit MXDM, select File→Exit. Exiting the application securely disconnects all active sessions.
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4 Navigating MXDM
This chapter discusses the following topics:

• “MXDM interface” (page 26)

• “MXDM banner” (page 27)

• “Using the MXDM menus” (page 28)

• “Using the MXDM toolbar” (page 30)

• “Selecting an area” (page 30)

• “Adjusting the display of an area” (page 31)

• “Using My Favorites pane” (page 31)

• “Using the navigation tree” (page 32)

• “Using the right pane” (page 34)

• “Working with windows, tabs, and panes” (page 35)

MXDM interface
Figure 5 (page 26) shows the MXDM interface.

Figure 5 MXDM interface

Table 3 (page 27) describes the parts in the MXDM interface.
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Table 3 Parts of the MXDM interface

DescriptionLabel

The MXDM banner displays information about the system,
user, and the default schema. For more information, see
“MXDM banner” (page 27).

MXDM banner

Displays the menus available in MXDM. For more
information, see “Using the MXDM menus” (page 28)

Menu bar

Displays the tools available in MXDM. For more
information, see “Using the MXDM toolbar” (page 30)

Tool bar

Displays the objects in the selected area.Selected tab

The right pane displays information about the selected
objects in theMy Favorites pane or in the navigation tree.

Right pane

For more information, see “Using the right pane” (page
34)

The MXDM status bar.Status bar

Displays the areas available in MXDM.Area tabs available

The navigation tree displays all the systems that you have
added using the Systems Tool. For more information,
see “Using the navigation tree” (page 32).

Navigation tree pane

Favorites appear in the My Favorites pane. For more
information, see “Using My Favorites pane” (page 31).

My Favorites pane

Displays the selected area.Selected area

Related Topics
“Using the MXDM toolbar” (page 30)
“MXDM banner” (page 27)
“Using the navigation tree” (page 32)
“Using the right pane” (page 34)
“Using My Favorites pane” (page 31)
“Using the MXDM menus” (page 28)

MXDM banner
The MXDM banner appears above the right pane. Figure 6 (page 27) shows the MXDM banner.

Figure 6 MXDM banner

The banner displays the following information:

• The name of the system

• The host and port information for the current connection

• The currently connected data source

• The user name

• The default schema
Related Topics
“MXDM interface” (page 26)
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Using the MXDM menus
MXDM includes the following menus:

• “Using the File menu options” (page 28)

• “Using the Edit menu options” (page 28)

• “Using the Tools menu options” (page 29)

• “Using the Windows menu options” (page 29)

• “Using the Help menu options” (page 29)

Using the File menu options
Table 4 (page 28) describes the File menu options.

Table 4 File menu options

DescriptionOption

Imports persistence data from a file that was saved using MXDM.

NOTE: All the current settings are replaced by the settings in the imported file.

Import Persistence

For more information, see “Saving and importing system definitions” (page 43).

Saves the current configuration.Save Persistence

Saves the configuration to any file. You can use the Export Persistence option to export
a specific configuration to other users in the organization. For more information, see “Saving
and importing system definitions” (page 43).

Export Persistence

Securely disconnects all active sessions. For more information, see “Exiting MXDM” (page
25).

Exit

Related Topics
“MXDM interface” (page 26)
“Saving and importing system definitions” (page 43)
“Exiting MXDM” (page 25)
“Using the MXDM menus” (page 28)
Terms
menu bar
persistence file
system definition

Using the Edit menu options
Table 5 (page 28) describes the Edit menu options.

Table 5 Edit menu options

DescriptionOption

Cancels the last operation.Undo

Reverses the last Undo command.Redo

Removes the selected text and copies it to the clipboard.Cut

Copies the selected text to the clipboard without removing it.Copy

Inserts the selected text at the cursor position.Paste

Highlights all text.Select All

Searches for database objects in the Database area.Find
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Related Topics
“Using the MXDM menus” (page 28)

Using the Tools menu options
Table 6 (page 29) describes the Tools menu options.

Table 6 Tools menu options

DescriptionOption

Launches the SQL Whiteboard. For more information on SQL Whiteboard, see “Using the
SQL Whiteboard” (page 145).

SQL Whiteboard

Launches RMXCI. For more information on RMXCI, see “Launching the NonStop SQL/MX
Remote Conversational Interface” (page 141).

SQL/MX Remote
Conversational
Interface

Opens the Systems Tool dialog. For more information on Systems Tool, see “Using the
Systems Tool” (page 20).

Systems Tool

Opens the Options dialog. For more information, see the following:Options
• “Adjusting the display of an area” (page 31)

• “Setting the timeout in MXDM” (page 23)

• “Setting Auto Logon options” (page 142)

Related Topics
“Using the MXDM menus” (page 28)
“Using the MXDM toolbar” (page 30)

Using the Windows menu options
Table 7 (page 29) describes the Windows menu options.

Table 7 Windows menu options

DescriptionOption

Displays the Windows Manager.Windows Manager

Closes all open windows except the main window.Close All

Related Topics
“Using the MXDM menus” (page 28)

Using the Help menu options
Table 8 (page 29) describes the Help menu options.

Table 8 Help menu options

DescriptionOption

Opens the MXDM online help and displays the Contents tab.Contents

Opens the MXDM online help and displays the Index tab.Index

Opens the MXDM online help and displays the Search tab.Search

Displays the About dialog. For more information, see “Obtaining version and build
information” (page 37).

About

Related Topics
“Using the MXDM menus” (page 28)
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Using the MXDM toolbar
MXDM includes tools in the toolbar that enable you to perform many common operations.
Table 9 (page 30) describes the MXDM tools.

Table 9 MXDM tools

DescriptionTool

Displays the Connect / Edit System dialog and enables you to connect to a system
or modify a system definition. For more information, see “Connecting to a system”
(page 19).

Enables you to disconnect the selected system. For more information, see
“Disconnecting from a system” (page 20).

Enables you to define, add, edit, remove, duplicate, test, and open connections to a
SQL/MX database using MXDM. For more information, see “Using the Systems Tool”
(page 20).

Enables you to use system definitions from a saved persistence file. For more
information, see “Saving and importing system definitions” (page 43).

Enables you to save the current settings. For more information, see “Saving and
importing system definitions” (page 43).

Enables you to remove the selected text and copy to the clipboard. For more
information, see “Using the Edit menu options” (page 28).

Enables you to copy the selected text to the clipboard. For more information, see
“Using the Edit menu options” (page 28).

Enables you to insert the selected text at the cursor position. For more information,
see “Using the Edit menu options” (page 28).

Launches the SQL Whiteboard. For more information, see “Introduction to the SQL
Whiteboard” (page 145).

Launches RMXCI. For more information, see HPE NonStop SQL/MX Remote
Conversational Interface (RMXCI) Guide or “Launching the NonStop SQL/MX Remote
Conversational Interface” (page 141).

Enables you to configure options and views. For more information, see “Using the
Tools menu options” (page 29).

Opens the Windows Manager that lists all the open windows and provides functions
to display and close these windows. For more information, see “Cloning tabs and
managing multiple open windows” (page 35).

Selects the next higher object in the navigation tree hierarchy. For example, if a table
is currently selected, clicking Go to Parent selects the table folder. Clicking the icon
again selects the schema icon.

Selects the previous object in the navigation tree hierarchy. If no other objects exist,
Go to Previous is disabled.

Selects the next object in the navigation tree hierarchy. If no other objects exist, Go
to Next is disabled.

Displays the online help.

Related Topics
“MXDM interface” (page 26)

Selecting an area
In MXDM, Database and Connectivity areas are available. The Database area includes all the
database objects that you can view and manage. The Connectivity area includes the MXCS
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objects that you can view and manage. To select an area, click the required tab below the
navigation tree pane. Table 10 (page 31) describes the areas available in SQL/MX Release 3.3.

Table 10 Supported areas

DescriptionArea

Provides information about the database objects. For more
information, see “Managing database objects” (page 45).

Database

Provides information about MXCS objects. For more information,
see “Managing MXCS objects” (page 121)

Connectivity

MXDM displays the currently selected area below the menu bar “MXDM interface” (page 26).
When you select an area, MXDM displays the characteristics of that area for all connected
systems.
Related Topics
“Adjusting the display of an area” (page 31)
Terms
area

Adjusting the display of an area
By default, MXDM displays all the supported areas. However, you can choose to display or hide
an area by using the Options menu.

To display theOptionsmenu, clickOptions( ) on the MXDM toolbar, or select Tools→Options.
The Options dialog appears. The Show/Hide Area Options pane shows the following
Connectivity and Database check-boxes.
To hide an area:
1. Clear the option for the required area in the Show/Hide Area Options pane.
2. Click OK.
To show an area that is hidden:
1. Select the option for the required area in the Show/Hide Area Options pane.
2. Click OK.
Related Topics
“Selecting an area” (page 30)
Terms
area

Using My Favorites pane
MXDM enables you to create favorites and organize them in folders. Subsequently, you can use
favorites to easily navigate to the required objects.
Favorites appear in the My Favorites pane.

Creating a folder to store favorites
In the My Favorites pane, you can create folders at the top level or folders within folders:
1. In the My Favorites pane, right-click the My Favorites folder and select New Folder

NOTE: To create a folder within an existing folder, right-click the folder, and select New
Folder

2. Assign a name for the folder, and click OK.
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Creating a favorite
To create a favorite, use one of the following methods:

• Drag and drop an object into theMy Favorites pane, as described in the following procedure:
1. Optional: If you want to create a favorite within a folder in the My Favorites pane, you

must create the folder first. For information on creating a folder, see “Creating a folder
to store favorites” (page 31).

2. In the navigation tree pane, navigate to the object.
3. Click and drag the object into the My Favorites pane. Drop the object at the required

location. A dialog prompts you to enter a name for the favorite.
4. Assign a name.
5. Click OK.

The favorite is created.

• Right-click an object and use the context menu options to create the favorite, as described
in the following procedure:
1. Optional: If you want to create a favorite within a folder in the My Favorites pane, you

must create the folder first. For information on creating a folder, see “Creating a folder
to store favorites” (page 31).

2. In the navigation tree pane, navigate to the object.
3. Right-click the object, and select Add To Favorites A dialog prompts you to enter a

name for the favorite.
4. Assign a name.
5. Click OK.

The favorite is created.

Using a favorite
To use a favorite, select the favorite in the My Favorites pane. Information about the favorite
appears in the right pane.

Displaying a list of favorites
To view a list of current favorites and folders in My Favorites, including the path to each favorite,
double-click the My Favorites folder in the My Favorites pane.
To view a list of favorites contained in a folder, including the path to each favorite, double-click
the folder.

Removing a favorite
To remove a favorite, right-click the favorite, and select Remove.

Considerations
You can create a favorite and store it in a folder. You can save your favorites and other
personalized client settings. However, you cannot perform the following actions:
• Move a favorite from one folder to another folder.

• Move a favorite that already exists under My Favorites into a folder.

• Rename the favorite folder or a favorite object.

Using the navigation tree
The navigation tree pane is available in the left pane of the MXDM GUI. For more information,
see “MXDM interface” (page 26). The navigation tree displays all the systems that you have
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added using the Systems Tool. System icons appear under the My Systems folder. A green
check box next to the system name indicates that the system is connected.
Figure 7 (page 33) shows the navigation tree with sample system names.

Figure 7 Navigation tree

When you select the Database area, you can view the database objects on the connected
systems, in the navigation tree.
The right pane displays more details about any object selected in the navigation tree pane. For
more information, see “Using the right pane” (page 34).
To add a new system, click Add at the bottom of the right pane. If systems have been added
previously, the right pane displays the active systems.
To display the options related to My Systems, right-click the My Systems folder. Table 11 (page
33) describes the options.

Table 11 Options related to the My Systems folder

DescriptionOption

Refreshes an object and its child objects in the navigation tree.Refresh

Adds a new system. For information on adding a system, see “Adding a system” (page 17).Add

To display the options related to a system that is connected, right-click the system name under
My Systems. Table 12 (page 34) describes the options.
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Table 12 Options related to a connected system

DescriptionOption

Launches the Create Catalog wizard to create a SQL/MX catalog on the selected system.
For more information, see “Creating a catalog” (page 48).

Create Catalog

Creates a shortcut for the object under My Favorites. You can launch the New Favorite
dialog to provide an alias for the object. For more information, see “Using My Favorites pane”
(page 31).

Add to Favorites

Refreshes the object and its child objects in the navigation tree.Refresh

Closes the connection with the system. For more information, see “Disconnecting from a
system” (page 20).

Disconnect

Tests whether the system definition is valid. For more information, see “Testing a system
definition” (page 23).

Test

Adds a system whose system definition is similar to the system definition of the selected
system. For more information, see “Copying a system definition” (page 22).

Add Like

Removes a selected system. For more information, see “Removing a system” (page 23).Remove

Launches the OSM Event Viewer in the default browser. You can use the search criteria to
search for events in the event log.

OSM Event Viewer

To display the options for a disconnected system, right-click the system name underMy Systems.
Table 13 (page 34) describes the options.

Table 13 Options related to a disconnected system

DescriptionOption

Creates a shortcut to the selected system. For more information, see “Using My Favorites
pane” (page 31).

Add to Favorites

Refreshes the object and its child objects in the navigation tree.Refresh

Establishes a connection with the system by using the values defined in the system definition.
For more information, see “Connecting to a system” (page 19).

Connect

Edits the system definition of a disconnected system. For more information, see “Editing a
system definition” (page 22).

Edit

Adds a system whose system definition is similar to the system definition of the selected
system. For more information, see “Copying a system definition” (page 22).

Add Like

Removes a selected system definition. For more information, see “Removing a system”
(page 23).

Remove

Related Topics
“MXDM interface” (page 26)
“Adding a system” (page 17)
“Using My Favorites pane” (page 31)
“Using the right pane” (page 34)
“Disconnecting from a system” (page 20)
Terms
My Systems

Using the right pane
The right pane displays information about the selected objects in the My Favorites pane or in
the navigation tree. Table 14 (page 35) describes the options displayed in the right pane when
you select the My Systems folder.
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Table 14 Options in the right pane for a connected system

DescriptionOption

Tests a selected system and displays the results in the Connection Test Result dialog. Test
is enabled when you select one or more systems.

Test

Edits the system definition of a disconnected or an inactive system. Edit is enabled when
you select one or more disconnected systems.

Edit

Adds a new system. Add is always enabled.Add

Adds a system whose system definition is similar to the system definition of the selected
system. Add Like is enabled when you select only one system.

Add Like

Removes a selected system definition. You must confirm the removal in the Confirm dialog.Remove

Closes the connection with the system. In the Confirm dialog, you must confirm whether
you want to disconnect the system.

Disconnect

When a table is displayed in the right pane, another set of options appears at the bottom of the
right pane. Table 15 (page 35) describes the options.

Table 15 Options in the right pane when a table is displayed

DescriptionOption

Copies the table data to the Windows clipboard. For more information, see “Copying data”
(page 42).

Data to Clipboard

Opens a browser to display the data in a tabular format. For more information, see “Copying
data” (page 42).

Data to Browser

Displays the data in a Microsoft Excel application. For more information, see “Copying data”
(page 42).

Data to Spreadsheet

Copies the data to a file in Comma Separated File (CSV) and HTML formats. For more
information, see “Copying data” (page 42).

Data to File

Related Topics
“MXDM interface” (page 26)
“Copying data” (page 42)
Terms
right pane
navigation tree pane

Working with windows, tabs, and panes
MXDM provides all of the conventional user-interface controls available in other Windows
applications. MXDM windows can be resized within permissible limits. When a window is resized,
graphical objects in a window get resized, if necessary.
To display information, MXDM provides the following features:
• Ability to clone windows and tabs, and manage multiple open windows from one dialog. For

more information, see “Cloning tabs and managing multiple open windows” (page 35).
• Ability to expand and collapse window panes. For more information, see “Expanding and

collapsing panes” (page 36)).

Cloning tabs and managing multiple open windows
MXDM enables you to clone the information available in some tabs, in a new window. A copy of
the selected tab and its information is created in a new window. MXDM also supports launching
multiple cloned windows simultaneously. As a result, you can launch multiple windows, resize
the windows, and compare the data in those windows. Cloning data and launching multiple
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windows are useful when you want to monitor multiple systems or multiple aspects of the same
system simultaneously.
To clone a tab, double-click the tab name, or right-click a tab name and select Clone in Window.
To manage multiple windows, MXDM includes the Windows Manager that lists all the open
windows, and provides functions to display and close these windows.

To open the Windows Manager, click Windows Manager ( ) on the MXDM toolbar, or select
Windows→Windows Manager.
Table 16 (page 36) describes the Windows Manager options.

Table 16 Windows Manager options

DescriptionOption

Moves the selected windows to the front.Activate

Closes the selected windows. However, the main window remains open.Close Window(s)

Displays the main window.Main Window

Closes Windows Manager.OK

Expanding and collapsing panes
Some MXDM windows contain controls that enable you to resize, expand, and collapse a pane
or part of a pane.
Figure 8 (page 36) shows the controls.

Figure 8 Window controls
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5 Performing basic MXDM operations
This chapter discusses the following topics:

• “Obtaining version and build information” (page 37)

• “Resolving errors and error messages” (page 37)

• “Sorting and moving data columns” (page 37)

• “Working with data grids” (page 38)

• “Copying data” (page 42)

• “Saving and importing system definitions” (page 43)

Obtaining version and build information
The version and build information appears in the About NonStop SQL/MX Database Manager
dialog. To open the dialog, selectHelp→About TheAbout NonStop SQL/MXDatabaseManager
dialog displays the current build information.
Figure 9 (page 37) shows the About NonStop SQL/MX Database Manager dialog.

Figure 9 About MXDM dialog

Resolving errors and error messages
For information on error messages, see HPE NonStop SQL/MX Release 3.4 Messages Manual
.
Related Topic
“Related documentation” (page 8)

Sorting and moving data columns
You might want to see rows in an MXDM display (for example, a list of schemas) grouped on
the basis of the information type. You can sort the displayed data in some tabs based on column
values. You can also change the order of the columns by dragging a column heading to the left
or right.
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To change the sort order of a displayed column, click the heading of the column that you want
to sort. A triangle appears at the right indicating the order.
Figure 10 (page 38) shows the column heading with the triangle.

Figure 10 Column sorting

To sort multiple columns, use the Ctrl key. MXDM numbers the selected columns and sorts the
data based on the order in which the columns are selected.
To move a displayed data column, drag the column heading and release at the required position.
Figure 11 (page 38) shows the changed order of Name and Metadata UID columns.

Figure 11 Changed order of columns

Working with data grids
This section discusses the following topics:

• “Introduction to data grids” (page 39)

• “Obtaining row details for a data grid” (page 39)

• “Copying data grid information” (page 40)

• “Customizing the data grid” (page 40)

• “Searching the data grid” (page 41)
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Introduction to data grids
The SQLWhiteboard Statement Details pane and theReport Results pane display information
in a data grid. The data grid is a simple table with columns that display data. You can manipulate
this data. Data grids enable you to perform the following tasks:

• Obtain details about a specific cell or a row.

• Issue commands.

• Sort data within a column.

• Rearrange columns.

• Copy cell or row information.

• Customize the display of information.

• Search for information in the grid.
Related Topics
“Obtaining row details for a data grid” (page 39)
“Copying data grid information” (page 40)
“Customizing the data grid” (page 40)
“Searching the data grid” (page 41)
Terms
data grid

Obtaining row details for a data grid
To obtain information about any row in a data grid, use one of the following methods:

• Right-click a cell in the row, and select Row Details.

• Double-click any cell in the data grid.
The Row Details dialog appears. Figure 12 (page 39) shows the Row Details dialog for alerts.

Figure 12 Row Details dialog
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The Row Details dialog displays all possible column information, whereas the data grid displays
only the grid columns that are currently configured using the Show/Hide Grid Columns option.
Arrows at the top of the dialog enable you to display details for other rows in the data grid without
exiting the Row Details dialog.
Figure 13 (page 40) displays the arrows that you can use to view details in multiple rows.

Figure 13 Displaying multiple rows in the data grid

Related Topics
“Introduction to data grids” (page 39)
“Customizing the data grid” (page 40)

Copying data grid information
To copy the data in cells, select the cells you want to copy, and then right-click and select Copy.
Figure 14 (page 40) shows how you can copy grid information.

Figure 14 Copying grid information

To copy data in noncontiguous cells, use the Ctrl key.
The cell values are copied into the Windows clipboard. From there, you can paste them into other
Windows applications.
Related Topics
“Introduction to data grids” (page 39)
“Customizing the data grid” (page 40)

Customizing the data grid
You can customize the columns in data grids. Table 17 (page 41) describes how you can
customize the columns.
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Table 17 Procedures to customize the data grid

Do thisTo

Show or hide columns 1. Right-click a column heading in any data grid, and select Show/Hide Grid
Columns. The Show/Hide Grid Columns dialog appears.

2. Select the columns that you want to display, and click OK.

NOTE: Click Defaults at any time to restore the default column selections.

Use one of the following methods:Change the order of displayed
columns • In the Show/Hide Grid Columns dialog, select a column, then click the up or

down arrows to change the position of the column:

• Click OK.

• In the data grid, click and drag the column to a new position. For more
information, see “Sorting and moving data columns” (page 37).

See “Sorting and moving data columns” (page 37).Sort information in the columns

Changes you make persist across MXDM sessions.
Related Topics
“Introduction to data grids” (page 39)

Searching the data grid
To search for a string, select any cell in the data grid, and then type the first few characters of a
string. MXDM locates the first occurrence of a cell within the same column that contains the
search string. Press Alt + ↓ and Alt + ↑ to switch to the next or previous occurrence of the search
string.
Figure 15 (page 42) shows how you can search for information in the grids.
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Figure 15 Searching for information

Related Topics
“Introduction to data grids” (page 39)

Copying data
You can copy data to different locations, and use the data for comparisons and analysis. This
section discusses the following topics:

• “Copying data to the clipboard” (page 42)

• “Copying data to a file” (page 42)

• “Copying data to a spreadsheet” (page 42)

• “Copying data to a browser” (page 43)

Copying data to the clipboard
Data to Clipboard saves the data to the clipboard. Each value is a double-quoted string.
Subsequently, you can paste the clipboard data to any Microsoft Windows document, such as,
Microsoft Excel, Microsoft Notepad, or Microsoft Word.

Copying data to a file
Data to File displays a window to copy the contents to a file. You can save the data in the Comma
Separated File Format (CSV) and HTML formats.

Copying data to a spreadsheet
Data to Spreadsheet transparently copies the table data to a temporary local file in standard
HTML table format, and then executes the file. A Microsoft Excel file that includes the table data
launches.
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Copying data to a browser
Data to Browser invokes Internet Explorer or a default browser that displays the table data. The
data is copied internally in standard HTML format. Internet Explorer is then invoked on a temporary
HTML file. You can then use Internet Explorer to save the contents.

NOTE: If the table has no data, the Copy buttons are disabled.

Saving and importing system definitions
MXDM enables you to save multiple system definitions and share them with other client
workstations. System definitions are saved in a persistence file. The persistence file is a binary
file that contains state and user preference information. The persistence file includes the following
information:

• System definitions

• User-specified options

• Favorites

• Statements executed from the SQL Whiteboard

• SQL Whiteboard layout information

• Setting timeout values
The persistence file is located in the default directory for your Windows user name. For example,
if your user name is janedoe, depending on the value of your HOME environment variable in
your workstation, the persistence file is located at:
• C:\Documents and Settings\janedoe\MXDatabaseManager in Windows XP.

• C:\Users\janedoe\MXDatabaseManager in Windows Vista
• C:\Users\janedoe\MXDatabaseManager in Windows 7
However, if a different directory is specified for the HOME environment variable of your workstation,
you can save the persistence file to a different location.
To save the currently defined system definitions, perform one of the following:

• On the MXDM toolbar, click Save Persistence ( ).

• Select File→Save Persistence.

NOTE: You do not need to save the persistence file. The persistence file is saved automatically
when you exit MXDM.

You can save system definitions in a data file. Subsequently, you can transfer the information to
the persistence file. To export a copy of the currently defined system definitions:
1. Select File→Export Persistence.

The Export Persistence dialog appears.
2. Specify a file name and a location for the copied persistence file.
3. Click OK.

The file is exported with the .mxdm extension.

You can import system definitions from a saved .mxdm file. When you import a persistence file,
active systems are disconnected. To import system definitions from a saved .mxdm file:
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1. Perform one of the following:

• Click Import Persistence ( ) on the MXDM toolbar.

• Select File→Import Persistence.
The Import Persistence dialog appears.

2. Select the previously exported .mxdm file, and click Open.
The Confirm dialog appears.

3. Click Yes.
MXDM copies the information from the .mxdm file into the persistence file and prompts you
to reconnect if you were connected to active systems.

Related Topics
“Using the MXDM menus” (page 28)
“Using the MXDM toolbar” (page 30)
Terms
persistence file
system definition
Systems Tool
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6 Managing database objects
This chapter discusses the following topics:

• “Searching database objects” (page 45)

• “Managing catalogs and their objects” (page 46)

• “Managing schemas and their properties ” (page 52)

• “Managing tables and their properties” (page 58)

• “Managing indexes and their properties” (page 80)

• “Managing views” (page 88)

• “Managing SQL/MP aliases” (page 101)

• “Managing sequence generators” (page 104)

• “Managing triggers” (page 111)

• “Refreshing database objects to get the current status” (page 116)

• “Managing objects using the SHOW DDL option” (page 116)

• “Displaying table statistics and their properties” (page 117)
For information on the database objects, see HPE NonStop SQL/MX Release 3.4 Reference
Manual.

Searching database objects
1. Log on to the NonStop SQL/MX Database Manager.
2. To open the Find dialog box:

• Click Edit→Find from the main menu.

• Click on the tool bar.

• Press Ctrl + F.
The Find dialog box appears.

Figure 16 Find dialog box
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3. Enter the name of the object in the Name field.
4. Select the type of object that you want to search from the Type drop-down.

If you select All Types, the search is for all types of objects with the specified object name.
5. Select the system in which you want to conduct the search from the System drop-down.

The system selected in the left pane of the main window is selected by default.
If the selected system is not connected, the Connect/Edit dialog box appears. You must
first connect to the system and then continue with the search. For more information, see
“Connecting to a system” (page 19).

6. In Look in:
• SelectAll Catalogs, to search for the object in all schemas in all catalogs of the selected

system.
• Select Catalog, to search for the object in all schemas of a specific catalog. Select the

catalog name from the Catalog drop-down.
• Select Schema, to search for the object in a specific schema within a catalog. Select

the catalog name and schema name from the respective drop-downs.
7. Optional. Select the Match case check box to perform a case-sensitive search.
8. Optional. Select the Match whole word check box to search for the complete name of the

object you have entered.
9. Click Find Next to view the next object matching your search criteria.
The object that matches your search criteria is selected in the navigation tree (left pane) and
displayed in the right pane.

Managing catalogs and their objects
Displaying catalogs

To display properties for a selected catalog:
1. Log in to the NonStop SQL/MX Database Manager.
2. In the navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Select a system from My Systems.
4. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
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5. Click a catalog from the list of catalogs.
Figure 17 (page 47) shows the catalog properties.

Figure 17 Catalog properties

The following tabs related to the catalog appear in the right pane:

• Attributes
• Registrations
• Schemas
• DDL

Displaying catalog attributes
To display the catalog attributes and their values:
1. In the navigation tree, select a catalog.
2. In the right pane, click Attributes.

The following attributes and their corresponding values appear:

• Name: — Specifies the name of the catalog.

• Metadata UID: — Specifies the internal UID number for this catalog.

• Location:— Specifies the location of the metadata tables for the catalog. It is the name
of an audited, non-SMF DAM volume on the local node.

Displaying catalog registrations
To display the catalog registrations and their values:
1. In the navigation tree, select a catalog.
2. In the right pane, click Registrations.

The following details appear:

• System:— Specifies the local or remote node name on which the catalog is registered.

• Location: — Specifies the volume name of the metadata tables for the catalog on local
or remote node where the catalog is registered.

• Rule: — Specifies the replication rule. This can be Automatic or Manual.
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Displaying catalog schemas
To display schemas in a catalog:
1. In the navigation tree, select a catalog.
2. In the right pane or the Schemas folder within the catalog, click Schemas.

The following fields appear:

• Name: — Specifies the name of the schema.

• Owner: — Specifies the authorization ID of the owner of the schema. The authorization
ID is the Guardian user name in group.user format.

• Version: — Specifies a number that indicates the SQL/MX version that is associated
with the schema.

• Location: —Specifies the designated volume and subvolume name for the schema.
The schema subvolume is the physical location for all the objects created within the
schema.

• Metadata UID: — Specifies the internal UID number for the schema.

Displaying catalog DDL
To display the catalog DDL:
1. In the navigation tree, select a catalog.
2. In the right pane, click DDL.

The DDL tab displays the SQL text that can be used to create the catalog.

NOTE: It is not the output of SHOWDDL command.

Creating a catalog
To create a catalog:
1. In the navigation tree, click Database.
2. In My Systems, select a system name.
3. Right-click the system name and select Create Catalog from the context menu.

Figure 18 (page 49) shows create catalog.
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Figure 18 Create catalog

4. Enter name of the catalog to be created.
5. Optional: Select a location from the list of audited volumes on the local node.

The list of audited volumes has the following fields:

• Name — Specifies the name of the audited volume.

• MB Total — Specifies the size of the volume in mega bytes.

• MB Free — Specifies the unused space on the volume in mega bytes.

• % Free — Specifies the unused space as a percentage of the total available space on
the volume.

• Free Extents — Specifies the number of free extents on the volume.

• Biggest Free — Specifies the size of the largest free extent on the volume.
6. Click Create to create the catalog in SQL/MX database.

Table 18 Create Catalog wizard buttons

FunctionButton

Creates a catalog.Create

Resets the selected tab in Create Catalog wizard.Reset

Closes the Create Catalog wizard.Cancel

Dropping a catalog
To drop a catalog:
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1. In the navigation tree, click Database.
2. In My Systems, select a system.
3. Click and expand the system.
4. Select a catalog, and then right-click and select Drop Catalog from the context menu.
5. Confirm Drop Catalog dialog appears with Yes or No option.
6. Click Yes to drop the catalog.

Registering a catalog
To register a catalog:
1. In the navigation tree, click Database.
2. In My Systems, select a system.
3. Click and expand the system.
4. Select a catalog, and then right-click and select Register/Unregister Catalog from the

context menu.
The Register/Unregister Catalog dialog is displayed with the selected catalog on the left
pane.
The registrations details are displayed in the Registrations grid in the right pane:
• System
• Location
• Rule

5. Click Register to display the Register Catalog dialog.
Figure 19 (page 51) shows the Register Catalog dialog.
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Figure 19 Register catalog

6. Select a node from the System drop-down list, the corresponding audited volumes are
displayed in the Location grid.

7. Select a volume from the Location grid.
8. Select Restrict or Cascade option.

• Select Restrict to register a named catalog. If the selected catalog is related to other
catalogs, an error occurs.

• SelectCascade to specify that this catalog and any catalogs that are directly or indirectly
related to it, will be registered.

9. Click OK to register the catalog.

Unregistering a catalog
To unregister a catalog:
1. In the navigation tree pane, click Database.
2. In My Systems, select a system.
3. Click and expand the system.
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4. Select a catalog, and then right-click and select Register/Unregister Catalog from the
context menu.
The Register/Unregister Catalog dialog is displayed with the selected catalog on the left
pane. The registration details are displayed in the Registrations grid in the right pane.
• System
• Location
• Rule

5. Select a row from the right pane.
The Unregister button is disabled if the replication rule is Automatic.

6. Click Unregister.
The Unregister Catalog dialog appears.

Figure 20 Unregister catalog

7. Select Restrict or Cascade option
• Select Restrict to unregister a named catalog. If the selected catalog is related to other

catalogs, an error occurs.
• SelectCascade to specify that this catalog and any catalogs that are directly or indirectly

related to it, will be unregistered.
8. Click OK to unregister the catalog.

Managing schemas and their properties
To display Schemas and their properties:
1. Log on to the MXDM.
2. In the navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

A list of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

A list of schemas appears.
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5. Click and select a particular Schema.
The following tabs related to the selected schema appear in the right pane:

• Attributes
• Tables
• Views
• Indexes
• Procedures
• SQL/MP Aliases
• Sequences
• DDL
Figure 21 (page 53) shows the schema properties.

Figure 21 Schema properties

Displaying schema attributes
To display the schema attributes and their values:
1. In the navigation tree, select a schema.
2. In the right pane, click Attributes.

The Attributes tab displays the following attributes and their values:

• Name — The name of the schema.

• Metadata UID — The internal UID number of the schema.

• Location — The physical volume and subvolume where the schema is located.

• Owner — The user who created the schema.

• Version — The schema version.

Displaying tables in a schema
To display the tables within a schema:
1. In the navigation tree, select a schema.
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2. In the right pane click Tables tab or click Tables folder in the schema.
The following details appear:

• Name: — The name of the table. Each table name is a hyperlink. Clicking the hyperlink
displays the details of the table.

• Metadata UID: — The internal UID number of the table.

• Creation Time — The time and date when the table was created. The Creation Time
attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the table was last redefined. The
Redefinition Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying views in a schema
To display the views:
1. In the navigation tree, select a schema.
2. In the right pane click Views tab or click Views folder in the schema.

The following details appear:

• Name — The name of the view. Each view name is a hyperlink. Clicking the hyperlink
displays the details of the view.

• Metadata UID — The internal UID number of the view.

• Creation Time — The time and date when the view was created. The Creation Time
attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the view was last redefined. The
Redefinition Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying indexes in a schema
To display the schema indexes:
1. In the navigation tree, select a schema.
2. In the right pane click Indexes tab, or click Indexes folder in the schema.

The following details appear:

• Name — The name of the index. Each index name is a hyperlink. Clicking the hyperlink
displays the details of the index.

• On — The table for which the particular index is created

• Metadata UID — The internal UID number of the index.

• Creation Time — The time and date when the index was created. The Creation Time
attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the index was last redefined. The
Redefinition Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying schema procedures
To display the schema procedures:
1. In the navigation tree, select a schema.
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2. In the right pane click Procedures tab or click Procedures folder in the schema.
The following details appear:

• Name — The name of the procedure. Each procedure name is a hyperlink. Clicking the
hyperlink displays the details of the procedure.

• Metadata UID — The internal UID number of the procedure.

• Creation Time — The time and date when the procedure was created. The Creation
Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the procedure was last redefined. The
Redefinition Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying SQL/MP aliases within a schema
To display the SQL/MP aliases that belong to a schema:
1. In the navigation tree, select a schema.
2. In the right pane click SQL/MP Aliases tab or click SQL/MP Aliases folder in the schema.

The following details appear:

• Name — The name of the SQL/MP alias. Each SQL/MP alias name is a hyperlink.
Clicking the hyperlink displays the details of the SQL/MP alias.

• Metadata UID — The internal UID number of the SQL/MP alias.

• Creation Time— The time and date when the SQL/MP alias was created. TheCreation
Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the SQL/MP alias was last redefined.
The Redefinition Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying sequence generators within a schema
To display the sequence generators that belong to a schema:
1. In the navigation tree, select a schema.
2. In the right pane click Sequences tab, or click the Sequences folder in the schema.

The following details appear:

• Name — The name of the sequence generator. Each sequence generator name is a
hyperlink. Click the hyperlink to display the details of the sequence generator.

• Metadata UID — The internal UID number of the sequence generator.

• Creation Time — The time and date when the sequence generator was created. The
Creation Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the sequence generator was last
redefined. TheRedefinition Time attribute is in the yyyy-MM-dd HH:mm:ss.FFFFFF
format.

Displaying schema DDL
To display the DDL of the schema:
1. In the navigation tree, select a schema.
2. In the right pane, click DDL.

In the right pane, an SQL statement appears. This SQL statement can be used in MXCI to
create the schema.
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Displaying other schema options

Displaying Show DDL option
To display the Show DDL option:
1. In the navigation tree, select a schema.
2. In the left pane, right-click and select Show DDL.

Show DDL dialog appears where objects can be selected to view their DDL output.

Displaying Show Schema Size option
To display the Show Schema Size option:
1. In the navigation tree, select a schema.
2. In the left pane, right-click and select Show Schema Size.

Show Schema Size dialog appears which displays the size of the underlying objects.

Creating a schema
To create a schema:
1. In the navigation tree, click Database and select a catalog.
2. In the left pane for a catalog or the Schemas folder within the catalog, right-click and select

Create Schema.
Create Schema dialog appears.

3. Enter the name of the schema to be created.
The schema is created within the catalog from where the Create Schema wizard was
launched. To create a schema in a different catalog, select a different catalog from the
catalog tree in the Create Schema wizard.

4. Check Set Owner To check box and select a user from the drop down to change the schema
owner to a user.

NOTE: Only SUPER user can use this option. If a NON-SUPER user tries to use it, SQL/MX
error 1023 is thrown.

5. Select Let SQL/MX choose the subvolume name to automatically generate a subvolume
name, or select a Subvolume Name to manually enter the subvolume name.

6. Select Repeat Use Allowed to allow NonStop SQL/MX to reuse subvolume names.
Schema gets created even if subvolume name is in use by another schema.
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7. Click Create to create the schema in selected catalog.

Figure 22 Create schema

Table 19 Create Schema wizard buttons

FunctionButton

Creates a schema within a catalog.Create

Resets the selected tab in Create Schema wizard.Reset

Closes the Create Schema wizard.Cancel

Dropping a schema
To drop a schema:
1. In the navigation tree, click Database and select a catalog.
2. In the left pane for Schemas folder within the catalog, select a schema and right-click and

select Drop Schema.
Confirm Drop Schema dialog appears.

3. Select Restrict or Cascade option.
• Select Restrict and an error is returned if the specified schema is not empty.

• Select Cascade to drop the schema in addition to the objects in the specified schema.
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4. Click Yes to drop the schema.

Managing tables and their properties
Displaying tables

To display the properties for a selected table:
1. Log onto the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.

The right pane displays the following tabs:
• Columns
• Primary Key
• Hash Key
• Store Order
• Check Constraints
• Unique Constraints
• Foreign Keys
• Attributes
• Partitions
• Related Objects
• DDL
• Statistics
• Privileges

Figure 23 Table properties

Additionally, each table has Indexes and Triggers folder. The Indexes folder comprise the list
of indexes for the corresponding table. For more information on indexes, see “Displaying indexes”
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(page 80). The Triggers folder comprises a list of triggers for the corresponding table. For more
information on triggers, see “Managing triggers” (page 111).

Displaying table column properties
To display the table column properties:
1. Select a table in the left pane.
2. In the right pane, click Columns.

The following details appear:

• Primary Key — An icon or key symbol to indicate that the column is part of the primary
key. If the column is not a part of the primary key, the field is blank.

• Column Name — The name of the column (string).

• Data Type — The SQL data type of the column.

• Nullable— If the column is NOT NULL DROPPABLE, the value displayed is Not Null.
If the column is NOT NULL NOT DROPPABLE, the value displayed is Not Null Not
Droppable.

• Default — A constant which is used when a row is inserted in the table without a value
for the column.

• Heading — The string is displayed at the top of the column values when a select
statement is executed on the table.

Displaying table primary key properties
To display the table primary key properties:
1. Select a table in the left pane.
2. In the right pane, click Primary Key.

The following details appear:

• Constraint Name — The name of the constraint when the table is created. For more
information, see HPE NonStop SQL/MX Release 3.4 Reference Manual.

• Metadata UID — The internal UID number for the constraint.

• Droppable — This property indicates whether this constraint can be dropped, by
specifying it while creating the table.

• Position — The position of the column in the table.

• Column Name — The name of the column (string).

• Data Type — The SQL data type of the column.

• Sort Order — The order specified as Ascending or Descending.

• Added By — This property indicates whether the column was added by the system or
by user.

Displaying hash key properties
To display the hash key properties:
1. Select a table in the left pane.
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2. In the right pane, click Hash Key.
The following details appear:

• Key Sequence: — The position of the column in the hash key order.

• Column Name: — The name of the column (string).

• Sort Order: — The order specified as Ascending or Descending.

Displaying store order properties
You can specify the store order properties while creating a table. Alternatively, the store order
properties can be determined by the system. For more information, see HPE NonStop SQL/MX
Release 3.4 Reference Manual. To display the store order properties:
1. Select a table in the left pane.
2. In the right pane, click Store Order.

The following details appear:

• Position: — The position of the column in the key, for the physical file.

• Column Name: — The name of the column (string).

• Sort Order: — The order specified as Ascending or Descending.

• Added By: — The property indicates whether the column was added by the system or
by the user.

Displaying check constraints
To display the check constraints for a table:
1. Select a table in the left pane.
2. In the right pane, click Check Constraints.

The following details appear:

• Constraint Name: — The name of the check constraint.

• Metadata UID: — The internal UID number for the constraint.

• Text: — A string that defines the constraint, as shown in the SHOW DDL output.

Displaying unique constraints
To display the unique constraints for a table:
1. Select a table in the left pane.
2. In the right pane, click Unique Constraints.

The following details appear:

• Constraint Name: — The name of the unique constraint.

• Metadata UID: — The internal UID number for the constraint.

• Columns: — The names of the columns in the constraint.

Displaying foreign key properties
To display the foreign key properties:
1. Select a table in the left pane.
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2. In the right pane, click Foreign Key.
The following details appear:

• Name: — The name of the foreign key constraint.

• Metadata UID: — The internal UID number of the foreign key.

• Referenced Table: — The name of the referenced table.

• Referencing Column: — The name of the referencing column of the foreign key.

• Referenced Column: — The name of the referenced column of the foreign key.

• Enforced: — The property indicates whether the referential integrity is enforced.

• On Delete: — The rule specifies the referential action that is taken when a row in
referenced table is deleted.

• On Update: — The rule specifies the referential action that is taken when column list
in referenced table is updated.

Displaying table attributes
To display the table attributes:
1. Select a table in the left pane.
2. In the right pane, click Attributes.

The following details appear:

• Name — The name of the table.

• Metadata UID — The internal UID number of the table.

• Last Updated Statistics— A string value of Never or a timestamp in the yyyy-MM-dd
HH:mm:ss.FFFFFF format.

• Audit Compressed— The property indicates whether the compressed audit-checkpoint
messages are generated for Disk Process 2 (DP2) files. It is expressed as True or
False.

• Clear On Purge — If the value is True, then the contents of the table are overwritten
when it is purged. Otherwise, the contents are not overwritten.

• Block Size — The length of a block.

• Maximum Size — The maximum size, expressed in megabytes, to which a table can
grow. If the maximum size is 0, then the string Determined by system appears.

• Record Size — The row size, expressed in bytes, in each logical record.

• Creation Time: — The time and date when a table was created. The time and date are
expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time: — The time and date when a table was last redefined. The time
and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying table partition properties
To display the partition properties:
1. Select a table in the left pane.

Managing tables and their properties 61



2. In the right pane, click Partitions.
The following details appear:

• Partition Number: — The index number of the partition.

• System: — The name of the NonStop system where this partition is located.

• Name: — The partition name that is created by the system or can be created by the
user.

• File: — The physical file where the partition is located.

• First Key: — This specifies the lowest values in the partition for columns stored in
ascending order and the highest values in the partition for columns stored in descending
order. It is displayed only if the table is range partitioned.

• Percent allocated: — The percentage of the partition used.

• Primary Extents: — The size of primary extents in pages.

• Secondary Extents: — The size of secondary extents in pages.

• Max Extents: — The maximum number of extents in the partition.

• Allocated Extents: — The number of extents allocated in the partition.

• Max Size: — The maximum size of the partition.

• Current EOF: — The space used in the partition.

Displaying information on related objects
To display information on related objects:
1. Select a table in the left pane.
2. In the right pane, click Related Objects.

The following details appear:

• Relationship: — This property specifies the relationship of the table with the object.
The available values for this field are Uses, Used By, and Has.

• Related Object Type: — This property specifies the type of the related object. The
available values are Table or View.

• Related Object Name: — This property specifies a three-part ANSI object name. The
object name is hyperlinked to the related object.

• Metadata UID: — The internal UID number of the related object.

• Creation Time: — The time and date when the related object was created. The time
and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time: — The time and date when the related object was last redefined.
The time and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying DDL information of a table
To display the DDL information related to a table:
1. Select a table in the left pane.
2. In the right pane, click DDL.

The DDL tab displays the SHOW DDL output for the table. You can use this statement in
MXCI to create the table. For more information on the SHOWDDL command, seeHPENonStop
SQL/MX Release 3.4 Reference Manual.
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Displaying information related to table privileges
To display the information related to the table privileges:
1. Select a table in the left pane.
2. In the right pane, select Privileges. The following details related to the table privileges

appear:
• Grantee: — The authorization ID of the user whose privilege is described.

• Grantor: — The authorization ID of the user who granted the privileges or the special
SQL user names PUBLIC and SYSTEM.

• With Grant: — The property indicates whether the user has grant privileges.

• Grant Level: — The level at which the permissions are visible. The column displays
schema, object, and column values.

◦ Schema: — Indicates that permissions are applied to the schema.

◦ Object: — Indicates that permissions were applied directly to the object whose
permissions are being displayed.

◦ Column: — Indicates that permissions are applied to the column. When an
object-level privilege applies to all columns, the individual column privileges do not
appear. Otherwise, the individual column permissions appear.

• Privileges:— Describes the privilege of the user. The value is a list of granted privileges
that are separated by a comma. DDL and DML privileges are grouped accordingly. For
the list of privileges, see HPE NonStop SQL/MX Release 3.4 Reference Manual.

Creating a table
NOTE: The video demonstrates the process of creating a table. For more information, see the
Create Table procedure in the subsequent section.
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To create a table:
1. Log onto the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Right-click the Tables folder or a Schema and select Create Table from the context menu.

The Create Table wizard appears.
7. Enter the name of the table to be created.

The table will be created in the schema that is currently selected in the schema tree.

NOTE: The Create button is disabled until all the relevant fields to create a table are
entered.

8. Set the following table attributes:
• Audit Compress
• Clear On Purge
• Block Size
• Allocate Extents

9. Click the Columns tab to add or configure columns of the table.
10. Click Add in the Columns tab to launch Specify Column dialog.
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Figure 24 Specify Column

11. Enter the various fields required to create a column.
The Specify Column dialog displays different set of properties to be set for their
corresponding data types. The following data types can be specified for the columns:
• Character

• Date

• Decimal

• Double Precision

• Float

• Integer

• Integer with identity column set

• Interval

• Largeint

• Largeint with identity column set

• NChar
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• Numeric

• Picture

• PictureComp

• Real

• Smallint

• Smallint with identity column set

• Time

• Timestamp

• Varchar

12. Click Edit in the columns tab to launch a dialog similar to Specify Column. In this dialog, the
existing values can be modified and updated accordingly.

13. Click Location tab.

Figure 25 Location tab

Location tab displays local node and the remote nodes connected through expand to local
node in the System list.

NOTE: If you are creating a table on remote node, the catalog on which the table is being
created must be registered on the remote NonStop system connected through MXDM.

The following attributes can be modified:
• Volume Name: — This is the data volume on which the primary partition of the table

will be created.
• Primary Extent Size: — This attribute specifies the size of the primary extent in pages.

• Secondary Extent Size: — This attribute specifies the size of the secondary extents
in pages.

• Max extents: — This attribute specifies the maximum number of extents.
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• Name: — This attribute specifies whether SQL/MX selects a name of the partition or is
user defined.

• Location: — This attribute specifies whether SQL/MX selects the file name or is user
defined.

14. Click Primary Key tab to add primary key constraint to the table.
This tab contains Columns Available and Columns in Primary Key grids. The Columns
Available grid is populated with all the columns that were added in Columns tab having
Not Null property set.

15. Select columns from the Columns Available grid, click Add to move them to the Columns
in Primary Key grid.
• Select columns from the Columns in Primary Key grid, click Remove to move back

the columns to the Columns Available grid.
• Click Move Up and Move Down buttons to change the order of the selected columns

in the Columns in Primary Key.
16. Click Store By tab to specify a set of columns on which to base the clustering key.

The clustering key determines the order of rows within the physical file that holds the table.
The storage order has an effect on how you can partition the object.

17. Click Unique Constraints tab to specify the unique constraints for the table.
A unique constraint is a column or table constraint that specifies that the column or set of
columns cannot contain more than one occurrence of the same value or set of values.

18. Click Check constraints tab to specify the check constraints for the table.
A check constraint is a constraint that specifies a condition that must be satisfied for each
row in the table.

19. Click Foreign Keys tab to specify the Foreign Key constraints for the table.
A foreign key constraint is a constraint that specifies a column or set of columns in table can
contain only values that match those in a column or set of columns in the referenced table.

20. Click Partitioning tab and then select either Range Partition or Hash Partition to define
the partitioning scheme for the table.

Figure 26 Partitioning tab

21. Click Secondary Partitions tab and click Add to add secondary partitions for the table.
Specify Partitions dialog appears.
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You can specify the node where the partition resides, volume, extent sizes, name of the
partition, and location. Based on the number of partitions per volume, the number of partitions
are added to the partitions list and the name of the node and volume are same for all.

22. Click Create to create the table with the set of values entered in the various tabs.

Table 20 Create Table wizard buttons

FunctionButton

Creates the table within a schema.Create

Resets the selected tab in Create Table wizard.Reset

Closes the Create Table wizard.Cancel

Altering a table
NOTE: To alter a table, you must be logged on as one of the following:
• The owner of the table.

• The owner of the schema that contains the table.

• The SUPER user.

To alter a table:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appear.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.

The following are the Alter Table options:
• Attributes — This menu item is used to alter the table attributes.

• Add Column(s) — This menu item is used to add new columns to the table.

• Add Primary Key— This menu item is used to add a primary key.

• Add Unique Constraint — This menu item is used to add an unique constraint.

• Add Check Constraint — This menu item is used to add a check constraint.

• Add Foreign Key — This menu item is used to add a foreign key.

• Alter Identity Column — This menu item is used to modify the identity column.

• Drop Foreign Key — This menu item is used to drop a foreign key.

• Drop Unique Constraint — This menu item is used to drop a unique constraint.

• Drop Check Constraint — This menu item is used to drop a check constraint.

• Drop Primary Key — This menu item is used to drop primary key of the table.
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Altering table attributes
To alter the attributes of a table:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table and then Attributes from the context menu.

Alter Attributes dialog appears.
The following attributes appear in the Alter Attributes dialog:
• Audit Compress: — This attribute controls whether unchanged columns are included

in audit records.
• Clear On Purge: — This attribute controls the disk cleanup when a table is dropped.

If Clear On Purge is selected, then the contents of the table are overwritten when it is
purged. Otherwise, NonStop SQL/MX deallocates disk space but does not physically
destroy the data in that disk space.

• Maximum Extents for every partition — This attribute sets the maximum number of
extents for all of the partitions. All the table partitions will have this maximum extents
value.

• Allocate/Deallocate for every partition— This attribute allocates the specified number
of extents for all partitions if Allocate is selected, or deallocates all extents from all
partitions if Deallocate is selected.

8. Select or clear the required attributes and click OK to alter the selected table.

Adding columns
To add a column:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and selectAlter Table and thenAdd Column(s) from the context menu.

Add Column(s) dialog appears.
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8. Click Add to launch the Specify Column dialog.
Specify Column dialog appears where you can enter the relevant details in the fields of the
dialog to create a new column for the table.

9. Click Edit to launch the Specify Column dialog with populated attribute values for the
selected column.
Specify Column dialog appears where you can modify the existing values for the selected
column.

10. ClickOK to apply the changes made in theAdd Column(s) dialog, or clickCancel to discard
the changes.

Adding primary key
To add a primary key:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Add Primary Key.

Add Primary Key dialog appears.
9. Select Let SQL/MX choose the name to generate the primary key constraint name

automatically, else explicitly provide a primary key constraint name in the Name field.
10. Select columns from the Columns Available grid and click Add to move them to the

Columns in Primary Key grid.

NOTE:
• At any point of time use Move Up or Move Down to change the order of the selected

columns in the Columns in Primary Key grid.
• The Add Primary Key context menu is disabled if the table already contains a primary

key.

11. Click OK to add primary key to the table.

Adding unique constraint
To add a unique constraint:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
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4. Click and expand the contents of a Catalog.
The list of schemas appears.

5. Expand a schema in the left pane.
The Tables folder appears.

6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Add Unique Constraint.

Add Unique Constraint dialog appears.
9. Select Let SQL/MX choose the name to generate the unique constraint name automatically,

else explicitly provide a unique constraint name in the Name field.
10. Select columns from the Columns Available grid and click Add to move them to the

Constraint Columns grid.

11. Click Remove to move back the columns to the Columns Available grid.
12. Click OK to add unique constraint to the table, else click Cancel to discard the changes.

Adding check constraint
To add a check constraint:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Add Check Constraint.

Add Check Constraint dialog appears.
9. Select Let SQL/MX choose the name to generate the check constraint name automatically,

else explicitly provide a check constraint name in the Name field.
10. Enter the constraint text in the text box.

11. Click OK to add check constraint to the table, else click Cancel to discard the changes.

Adding foreign key
To add a foreign key:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
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5. Expand a schema in the left pane.
The Tables folder appears.

6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Add Foreign Key.

Add Foreign Key dialog appears.
9. Select Let SQL/MX choose the name to generate the foreign key constraint name

automatically, else explicitly provide a foreign key constraint name in the Name field.
10. Select referential action for On Delete and On Update rules. The following are the possible

values:
• No Action
• Restrict
• Cascade
• Set Default
• Set Null

11. Select a table from the Referenced Table tree and click Add to launch Specify Foreign
Key Column Pair dialog to add the column pairs.
Specify Foreign Key Column Pair dialog appears with Referencing Columns and
Referenced Columns grids.

12. Select a column from theReferencing Columns grid to populate theReferenced Columns
grid with the columns that match the data type of the referencing column.

13. Click OK to add a column pair in Add Foreign Key dialog.
14. Click OK to add foreign key to the table or click Cancel to discard the changes.

Altering identity column
To alter identity column:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.

NOTE: Alter Identity Column menu is enabled only if the table contains an Identity
Column.

8. Select Alter Identity Column.
Alter Identity Column dialog appears.
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9. Select either of the following:
• Max Value
• Increment By
• Recalibrate
• Recalibrate To

10. Enter an appropriate value in the Value text box except for Recalibrate option.
11. Click OK to alter the identity column, else click Cancel to discard the changes.

Dropping foreign key
To drop a foreign key:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.

NOTE: Drop Foreign key menu is enabled only if the table contains a foreign key.

8. Select Drop Foreign Key.
Drop Foreign Key dialog appears.

9. Select a foreign key.
10. Select either of the following:

• Restrict: If constraints are dependent on this constraint, it cannot be dropped.

• Cascade: If referential constraints are dependent on this constraint, those dependent
constraints are dropped along with the specified constraint being dropped.

11. Click Drop button to drop the selected foreign key

Dropping unique constraint
To drop unique constraint:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
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6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Drop Unique Constraint.

Drop Unique Constraint dialog appears.
9. Select a unique constraint.
10. Select either of the following:

• Restrict — If the referential constraints are dependent on this constraint, it cannot be
dropped.

• Cascade — If the referential constraints are dependent on this constraint, those
dependent constraints are dropped along with the specified constraint.

11. Click Drop buttton drop the selected unique constraint.

Dropping check constraint
To drop a check constraint:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Drop Check Constraint.

Drop Check Constraint dialog appears.
9. Select a check constraint.
10. Select either of the following:

• Restrict — If the referential constraints are dependent on this constraint, it cannot be
dropped.

• Cascade— If the referential constraints are dependent on this constraint, the dependent
referential constraints are dropped along with the specified constraint.

11. Click Drop button to drop the selected check constraint.

Dropping primary key
To drop a primary key:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
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5. Expand a schema in the left pane.
The Tables folder appears.

6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Alter Table from the context menu.
8. Select Drop Primary Key.

Drop Primary Key dialog appears.
9. Select either of the following to drop the primary key:

• Restrict — In case where the referential constraints are dependent on this constraint,
it cannot be dropped.

• Cascade — In case where the referential constraints are dependent on this constraint,
dependent referential constraints are dropped along with the specified constraint.

10. Click Yes to drop the primary key or No to discard the changes.

Dropping a table
To drop a table:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Drop Table from the context menu.

Drop Table confirmation dialog appears.
8. Select either of the following to drop the table:

• Restrict— If the table is referenced by a view, trigger, or referential constraint of another
table, or if the table has an active DDL lock, the specified table cannot be dropped. This
is the default option.

• Cascade— In this case, the table and all the views, triggers, referential constraints and
inactive DDL locks are also dropped.

NOTE:
• To drop a table, you must own the schema which contains the table or be the super ID

or object owner.
• A table that has an active DDL lock cannot be dropped even if you select CASCADE.

An active DDL lock is released when the utility locking the file completes.

9. Click Yes to drop a table or No to discard the changes.

Renaming a table
Renaming a table changes the logical name of the table within the schema.
To rename a table:
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1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click the table and select Rename Table from the context menu.

Rename Table dialog appears.
8. Enter the new ANSI name of the table.
9. SelectCascade to automatically rename the system generated ANSI names of indexes and

constraints associated with the table.
10. Click OK to rename the table, else click Cancel to discard the changes.

NOTE: Renaming a table changes the text of referencing views, RI constraints, and triggers
to reference the new name.

Creating a table using existing table
To create a table using an existing table definition:
1. Log on to the MXDM.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
4. Click and expand the contents of a Catalog.

The list of schemas appears.
5. Expand a schema in the left pane.

The Tables folder appears.
6. Expand the Tables folder and select a table in the left pane.
7. Right-click on the table and select the Create Table Using option from the context menu.

Create Table window is launched preloaded with the values of the selected table definition
except the table name field.
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8. Click Create to create a table after modifying the required values.

NOTE:
• MXDM allows you to add, remove, or modify existing column definition in Create Table

Using.
• The selected table’s check constraints are not loaded in Create Table window.

Table 21 Create Table Using buttons

FunctionButton

Creates the table within a schema.Create

Restores the original table definition by performing a reset on all the tabs.Reload

Closes the Create Table wizard.Cancel

Granting privileges on a table
You can grant the following privileges on a table to specific users: select, insert, delete, column
reference, and column update.
1. Log on to the NonStop SQL/MX Database Manager.

To grant privilege on a table, log in as the owner of the table, the security administrator, a
user with grant privileges, or as SUPER.SUPER user if the Security Administrator group is
empty.

2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems
→Catalogs→Schemas.

3. Expand Tables folder and select the table on which you want to grant privileges.
4. Right-click and select Grant/Revoke Privileges.

The grant/revoke privileges options appear in the right pane. The Grant option is selected
by default.
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Figure 27 Granting privileges on a table

5. In the Grantees section, select Public to grant privileges to all users.
Or, select Specified Users to grant privileges to specific users.
If Specified Users option is selected, the user grid is enabled.

6. Optional. In the user grid, press Ctrl and click on the desired user names to select users.
7. Optional. In Grantor section, select By User option and select the user name in the

corresponding drop-down menu to grant privileges on behalf of another user.
8. Optional. Select With Grant Option to grant privileges and allow the grantees to grant the

selected privileges to other users.
9. Optional. In the Operation section, select All Privileges check box to grant all privileges.

If the All Privileges option is selected, then the options in the Table Privileges, Column
Reference Privileges, and Column Update Privileges sections are disabled.

10. Select the desired options in the Table Privileges section.
The available options are Select, Insert, and Delete.

11. In the Column Reference Privileges section, select one of the following options:
• Select All Column to grant reference privilege on all columns.

• Select Specified Columns to grant reference privilege on specific columns.
If the Specified Columns option is selected, then the list of columns is enabled.

• Press Ctrl, and click on the desired column names to select columns.

• Selecting the No Columns option does not grant reference privileges.
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12. In the Column Update Privileges section, select one of the following options:
• Select All Column to grant update privilege on all columns.

• Select Specified Columns to grant update privilege on specific columns.
If the Specified Columns option is selected, then the list of columns is enabled.

• Press Ctrl and click on the desired column names to select columns.

• Selecting the No Columns option does not grant update privileges.
13. Click Grant.

Revoking privileges on a table
You can revoke the following privileges on a table from specific users: select, insert, delete,
column reference, and column update.
1. Log on to the NonStop SQL/MX Database Manager.

To revoke privilege on a table, log in as the owner of the table, the security administrator,
or as SUPER.SUPER user if the Security Administrator group is empty.

2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems
→Catalogs→Schemas.

3. Expand Tables folder (left pane) and select the table on which you want to revoke privileges.
4. Right-click and select Grant/Revoke Privileges.

The grant/revoke privileges options appear in the right pane.
5. Select the Revoke option to revoke privileges.
6. Optional. In the Operation section, select All Privileges check box to revoke all privileges.

If the All Privileges option is selected, then the options in the Table Privileges, Column
Reference Privileges, and Column Update Privileges sections are disabled.

7. Optional. Select Grant Option For to revoke the With Grant Option for the privilege and
not the privilege itself.

8. In the Grantees section, select Public to revoke privileges from all users.
Or, select Specified Users to revoke privileges from specific users.
If the Specified Users option is selected, then the user grid is enabled.

9. Optional. In the user grid, press Ctrl and click on the desired user names to select users.
10. Optional. In Grantor section, select By User option and select the user name in the

corresponding drop-down menu to revoke privileges on behalf of another user.
Select Cascade option to revoke dependent privilege descriptors and objects. If cascade is
not selected, Revoke is executed with RESTRICT option.

11. Optional. Select With Grant Option to grant privileges and allow the grantees to revoke the
selected privileges from other users.

12. In the Column Reference Privileges section, select one of the following options:
• Select All Column to revoke reference privilege on all columns.

• Select Specified Columns to revoke reference privilege on specific columns.
If the Specified Columns option is selected, then the list of columns is enabled.

• Press Ctrl and click on the desired column names to select columns.

• Selecting the No Columns option does not revoke reference privileges.
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13. In the Column Update Privileges section, select one of the following options:
• Select All Column to revoke update privilege on all columns.

• Select Specified Columns to revoke update privilege on specific columns.
If the Specified Columns option is selected, then the list of columns is enabled.

• Press Ctrl and click on the desired column names to select columns.

• Selecting the No Columns option does not revoke update privileges.
14. Click Revoke.

Managing indexes and their properties
Displaying indexes

To display properties for a selected index:
1. Log into the NonStop SQL/MX Database Manager.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Select a system from My Systems.
4. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
5. Select a catalog and then expand Schemas folder within it.

List of schemas appears.
6. Expand a selected schema and select Tables folder.
7. Expand the Tables folder.

List of tables appears.
8. Select and expand a table within it.

Indexes and Triggers folders appear.
9. In the Index folder, select the required index.

In the right pane, the following tabs related to index appear:
• Columns
• Attributes
• DDL
• Partitions
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Figure 28 Table index properties

Displaying the table index columns
To display the table index columns:
1. In the navigation tree, select an index.
2. In the right pane, select Columns.
The following attributes and their values appear:
• Column Name — The name of the column (string).

• Sort Order — This attribute specifies the sort order as Ascending or Descending.

• Added By — This attribute indicates whether the column was added by the system or a
user.

Displaying the table index attributes
To display the table index attributes:
1. In the navigation tree, select an index.
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2. The following attributes and their values appear:
• Name — The name of the index.

• Metadata UID — The internal UID number of the index.

• Unique — This attribute specifies whether the index is unique. The value can be Yes
or No.

• Populated — This attribute specifies whether the index is populated. The value can be
Yes or No.

• System Created — This attribute indicates whether the index was created by the
system. The value can be Yes or No.

• Hash Partitioned— This attribute indicates whether the index is partitioned by a hashing
key. The value can be Yes or No.

• Audit Compressed — This attribute indicates whether compressed audit-checkpoint
messages are generated for Disk Process 2 (DP2) files. The value can be ON or OFF.

• Block Size — The length of a block in bytes.

• Clear On Purge — This attribute indicates whether the disk is erased when the index
is dropped. If the value is True, then the contents of the index are overwritten when it
is purged. Otherwise the contents are not overwritten.

• Creation Time — The time and date when the index was created. The time and date
are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the index was last redefined. The time
and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying the DDL output for a table index
To display the DDL output for a table index:
1. In the navigation tree, select an index.
2. In the right pane, click DDL.

The DDL tab displays the SHOW DDL output for the index. For more information on the
SHOW DDL command, see HPE NonStop SQL/MX Release 3.4 Reference Manual.

Displaying information for table index partitions
To display information related to table index partitions:
1. In the navigation tree, select an index.
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2. In the right pane, click Partitions.
The following details related to table index partitions appear:
• Partition Number — This is an integer which starts at zero for the main partition and

1 and above for the secondary partitions.
• System — The name of the NonStop system where this partition is located.

• Name — This is the name of the partition.

• File — The physical file where the partition is located.

• First Key — This specifies the lowest values in the partition for columns stored in
ascending order and the highest values in the partition for columns stored in descending
order. It is displayed only if the index is range partitioned.

• Percent Allocated — The percentage of the partition used.

• Primary Extents — The size of the primary extent in pages.

• Secondary Extents — The size of the secondary extents in pages.

• Max Extents — The maximum number of extents.

• Allocated Extents — The number of extents allocated.

• Max Size — The maximum size of the partition.

• Current EOF — The space used in the partition.

Creating an index
To create an index:
1. Log into the NonStop SQL/MX Database Manager.
2. In the Navigation tree pane, click Database.

MXDM displays a list of available systems in My Systems.
3. Select a system from My Systems.
4. Expand a selected system in the navigation tree.

List of catalogs for the selected system appears.
5. Select a catalog and then expand Schemas folder within it.

List of schemas appears.
6. Expand a selected schema and select Tables folder.
7. Expand the Tables folder.

List of tables appears.
8. Select and expand a table within it.

Indexes and Triggers folders appear.
9. Right-click on the Indexes folder for that table or a table and select Create Index context

menu.
Create Index wizard launches with the General Properties tab as the default selection.
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Figure 29 Create Index wizard

10. In the General Properties tab, enter the name of the index to be created. Index will be
created for the table that is currently selected in the Table tree.

11. Set the following index attributes:
• Audit Compress
• Block Size
• Unique
• Clear On Purge
• Allocate Extents
• Populate

12. Click Columns tab.
13. In the Columns tab, select columns from the Columns Available grid and click Add.

The selected columns get moved to the Columns in Index grid.

• On the right grid, select columns from the Columns in Index grid and click Remove.
The selected columns get moved to the Columns Available grid.

• In the Columns in Index grid, select Ascending check box for columns to sort the
resulting index in ascending order.

• In the Columns in Index grid, select one or more columns and click Move Up or Move
Down button to change the position of those columns.
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14. Click Location tab.
Location tab displays local node and the remote nodes connected through expand to local
node in System list. In the Location tab:

• Select a system name from the system drop down.

• Specify the following attributes as needed:

◦ Volume Name — This is the data volume on which the primary partition of the
index will be created.

◦ Primary Extent Size — This attribute specifies the size of the primary extent in
pages.

◦ Secondary Extent Size— This attribute specifies the size of the secondary extents
in pages.

◦ Max extents — This attribute specifies the maximum number of extents.

◦ Name — This attribute specifies whether SQL/MX selects a name of the partition
or is user defined.

◦ Location — This attribute specifies whether SQL/MX selects the file name or is
user defined.

15. Click Partitioning to specify whether or not the index has secondary partitions.
In the Partitioning tab:
• Select Range Partition or Hash Partition and add a secondary partition in Secondary

Partitions.
• Select By Columns check box to create partition using specific columns.

• Move the columns from the Columns Available list to Partition By Columns list.

• Click the Move Up and Move Down buttons to change the order of the columns in the
Partition By Columns list.

16. Click Secondary Partitions tab to add secondary partitions.
In the Secondary Partitions tab:
• Click Add to launch Specify Partition dialog. In the Specify Partition dialog, specify

the node where the partition resides, volume, extent sizes, name of the partition, and
location.
Based on the value of the Partitions per volume field, the specified number of partitions
will be added to the partitions list.

• Specify the first key value for the partition being created. The First Key Value field will
not be displayed if Hash Partitioning was specified in the Partitions tab.

• To specify the first key value for a partition, select the corresponding partition row, type
the first key value and then click Apply.

• Click Reload to copy the first key value of the selected partition row to the First Key
Value field.

• Click Remove to remove the partition rows that are selected.

• Click Edit to launch the Specify Partition dialog, modify the node where the partition
resides, volume, extent sizes, name of the partition, and location.
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17. Click the Create to create index.

Table 22 Create Index wizard buttons

FunctionButton

Creates an Index on the selected table.Create

Resets the selected tab in Create Index wizard.Reset

Closes the Create Index wizard.Cancel

Altering an index
To alter an index:
1. In the navigation tree pane, select a catalog and then expand Schemas folder within it.

List of schemas appears.
2. Expand a selected schema and select Tables folder.
3. Expand the Tables folder.

List of tables appears.
4. Select and expand a table within it.

Indexes and Triggers folders appear.
5. Expand the Indexes folder.

List of indexes appears.
6. Select an index name and then right-click and select Alter Index.

Alter Index dialog appears with the existing values of the index.

Figure 30 Alter Index dialog
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The following attributes appear in the Alter Index dialog:
• Audit Compress — This attribute controls whether unchanged columns are included

in audit records.
• Clear On Purge — This attribute controls the disk cleanup when an index is dropped.

If Clear On Purge is selected, then the contents of the index are overwritten when it is
purged. Otherwise, NonStop SQL/MX deallocates disk space but does not physically
destroy the data in that disk space.

• Maximum Extents for every partition — This attribute sets the maximum number of
extents for all of the partitions. All the index partitions will have this maximum extents
value.

• Allocate/Deallocate for every partition— This attribute allocates the specified number
of extents for all partitions if Allocate is selected, or deallocates all extents from all
partitions if Deallocate is selected.

7. Select or clear the required attributes and click OK to alter the selected index.

Renaming an index
To rename an index:
1. In the navigation tree pane, select a catalog and then expand Schemas folder within it.

List of schemas appears.
2. Expand a selected schema and select Tables folder.
3. Expand the Tables folder.

List of tables appears.
4. Select and expand a table within it.

Indexes and Triggers folders appear.
5. Expand the Indexes folder.

List of indexes appears.
6. Select an index name, and then right-click and select Rename Index.

Rename Index dialog appears.
7. Enter the new name for the selected index.
8. Enter OK to rename the index.

Dropping an index
To drop an index:
1. In the navigation tree pane, select a catalog and then expand Schemas folder within it.

List of schemas appears.
2. Expand a selected schema and select Tables folder.
3. Expand the Tables folder.

List of tables appears.
4. Select and expand a table within it.

Indexes and Triggers folders appear.
5. Expand the Indexes folder.

List of indexes appears.
6. Select an index name and then right-click and select Drop Index.

Confirm Drop Index dialog with Cascade and Restrict options appears.
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7. Select either of the following options:
• Restrict — If the index is being used to validate a constraint, then the index is not

dropped.
• Cascade — If the index is being used to validate a constraint, both the constraint and

index are dropped.
8. Click Yes to drop the selected index.

Managing views
Views

A view provides an alternate way of looking at data in one or more tables. A view is a named
specification of a result table, which is a set of rows selected or generated from one or more
base tables or other views. For information on the views, see HPE NonStop SQL/MX Release
3.4 Reference Manual.
You can create, alter, rename, and drop a view and also display the properties of the view using
MXDM.

Managing views and their properties
You can perform the following operations on views from MXDM:
• Creating a view

• Altering a view

• Renaming a view

• Dropping a view

• Granting privileges on a view

• Revoking privileges on a view

• Viewing properties

Prerequisites

• To create a view, log in as the owner of the schema that contains the view or as
SUPER.SUPER user.

• To alter, rename, and drop a view, log in as the owner of the view, the owner of the schema
that contains the view, or as SUPER.SUPER user.

• To grant privilege on a view, log in as the owner of the view, the security administrator, a
user with grant privileges, or as SUPER.SUPER user if the Security Administrator group is
empty.

• To revoke privilege on a view, log in as the owner of the view, the security administrator, or
as SUPER.SUPER user if the Security Administrator group is empty.

Creating a view
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to the Views folder by expanding Database→My Systems

→Catalogs→Schemas→Views.
3. Right-click on the Views folder and select Create View from the context menu.

The Create View wizard launches with General Properties as the default selection.
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Figure 31 Create View

4. Click General Properties tab.
• Enter the name of the view to be created.

• Specify Attributes by selecting or clearing Similarity Check and With Check Option.
For more information, see HPE NonStop SQL/MX Reference Manual.

The view is created in the schema from where you launched the Create View wizard. To
create a view in a different catalog or schema, select another catalog and schema from the
list displayed in the schema area.
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5. Click Headings and Expressions tab.
Add, edit, or remove column names and headings for a view by using the Add, Edit, and
Remove buttons. Adding column names and headings are optional. While adding a column,
you must specify the column name and the heading is optional.
In the Query Expression pane, you can type an SQL/MX expression to define the view.
This excludes headings, similarity check, location, and check options.

6. In the Location tab, select the system and volume name where the view will reside.
You can let SQL/MX determine the name of the physical file for the view or enter the file
name in the text box. The file name must start with a name and have six characters. It can
be alphanumeric.

7. Optional. Click Preview tab to view the DDL statement that is constructed from the inputs
provided.
You cannot modify this text. If there are any errors in the view creation, it is displayed in this
tab.
Click Back, to modify the information in the previous tabs. The changes are automatically
be reflected in the DDL statement.

8. Click Create.

Altering a view
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Expand the Views folder (left pane) or click the Views tab (right pane), and select the view

you want to alter.
4. Right-click and select Alter View.

TheAlter View dialog box appears. If similarity check is disabled in the view, then the Enable
Similarity Check option is selected in the Alter View dialog box. And if similarity check is
enabled in the view, then the Disable Similarity Check option is selected in the Alter View
dialog box.

5. Click OK.
Navigate to the Attributes tab of the view, to view the modification for the Similarity Check
entry.

Renaming a view
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand the Views folder (left pane) or click the Views tab (right pane), and select the view

you want to rename.
4. Right-click and select Rename View.

The Rename View dialog box appears.
5. Enter a new name for the view and click OK.

Dropping a view
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
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3. Expand the Views folder (left pane) or click the Views tab (right pane), and select the view
you want to remove.

4. Right-click and select Drop View.
The Confirm Drop View dialog box appears.

5. Select Restrict or Cascade, and click Yes.
If you select Restrict, the view is not dropped if it is referenced from another view or from
any other object.
If you select Cascade, any dependent objects on the view are also dropped.

Granting privileges on a view
You can grant the following privileges on a view for specific users or public: select, insert, and
delete a table, column reference, and column update.
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Expand the Views folder and select the view for which you want to grant privileges.
4. Right-click and select Grant/Revoke Privileges.

The grant/revoke privileges options appear in the right pane. The Grant option is selected
by default.

Figure 32 Grant/Revoke Privileges on a view

5. In the Grantees section, select Public to grant privileges to all users.
Or, select Specified Users to grant privileges to specific users.
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If the Specified Users option is selected, the user grid is enabled. Press Ctrl and click on
the desired user names to select users.

6. Optional. Select By User and select the user name in the corresponding drop-down menu
to grant privileges on behalf of another user.

7. Optional. Select With Grant Option to grant privileges and allow the grantees to grant the
selected privileges to other users.

8. Optional. In theOperation section, select theAll Privileges check box to grant all privileges.
If the All Privileges check box is selected, then the options in the View Privileges, Column
Reference Privileges, and Column Update Privileges sections are disabled.

9. Select the desired options in the View Privileges section.
The available options are Select, Insert, and Delete.

10. In the Column Reference Privileges section:
• Select All Column to grant reference privilege on all columns.

• Select Specified Columns to grant reference privilege on specific columns.
If the Specified Columns option is selected, the list of columns is enabled.

• Press Ctrl and click on the desired column names to select columns.

• Selecting the No Columns option does not grant reference privileges.
11. In the Column Update Privileges box:

• Select All Column to grant update privilege on all columns.

• Select Specified Columns to grant update privilege on specific columns.
If Specified Columns is selected, then the list of columns is enabled.

• Press Ctrl and click on the desired column names to select columns.

• Select No Columns to not grant any update privileges.
12. Click Grant.

Revoking privileges on a view
You can revoke the following privileges on a view from specific users or public: select, insert,
and delete a table, column reference, and column update.
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Expand the Views folder and select the view for which you want to revoke privileges.
4. Right-click and select Grant/Revoke Privileges.

The grant/revoke privileges options appear in the right pane.
5. Select Revoke to revoke privileges.
6. Optional. In theOperation section, select theAll Privileges check box to revoke all privileges.

If theAll Privileges option is selected, the options in theViewPrivileges,ColumnReference
Privileges, and Column Update Privileges sections are disabled.

7. Optional. Select Grant Option For to revoke the With Grant Option for the privilege and
not the privilege itself.

8. In the Grantees section, select Public to revoke privileges from all users.
Or, select Specified Users to revoke privileges from specific users.
If the Specified Users option is selected, the user grid is enabled. Press Ctrl and click on
the desired user names to select users.
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9. Optional. Select By User and select the user name in the corresponding drop-down menu
to revoke privileges on behalf of another user.
Select Cascade to revoke dependent privilege descriptors and objects. If Cascade is not
selected, Revoke is executed with RESTRICT option.

10. Select the desired options in the View Privileges section.
The available options are Select, Insert, and Delete.

11. In the Column Reference Privileges section:
• Select All Column to grant reference privilege on all columns.

• Select Specified Columns to grant reference privilege on specific columns.
If Specified Columns is selected, the list of columns is enabled. Press Ctrl and click
on the desired column names to select columns.

• Select No Columns to not revoke any reference privileges.
12. In the Column Update Privileges section:

• Select All Column to grant update privilege on all columns.

• Select Specified Columns to grant update privilege on specific columns.
If Specified Columns is selected, the list of column names is enabled. Press Ctrl and
click on the desired column names to select columns.

• Select No Columns to not revoke update privileges.
13. Click Revoke.

Viewing properties
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
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3. Expand the Views folder and select a view.

The right pane displays the following tabs:
View related columns

Displays the column information for the view.
View related attributes

Displays the attributes information for the view.
View related objects

Displays the relationships of the view with other objects, if any.
DDL

Displays the SQL/MX statement used to create the view.
View related privileges

Displays the privileges of the user for a view.

View related columns
Column Name

The name of the column.
Source Object

The name of the source object associated with the column. If the source object is a computed
object, this field is blank. The object name is a hyperlink and clicking on the object name
enables you to navigate to that object.

Data Type
The SQL data type of the column.

Nullable
If the column is NOT NULL, then the value displayed is Not Nullable. If the column is NOT
NULL NOT DROPPABLE, then the value displayed is Not Nullable Not Droppable. Otherwise,
the value is blank.

Default
The default value of the column.

Heading
The string that is used as a heading for the column. Headings can be specified when creating
a view.
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View related attributes
Name

The name of the view.
Metadata UID

The internal UID number of the view.
Check Option

Displays one of the following values: None, Local, and Cascade.
Similarity Check

Indicates if the similarity check option is enabled or not. It is displayed only if the schema
version is created using SQL/MX 3.2 or later versions.

View related objects
Relationship

Specifies the relationship between the view and the object.
Related Object Type

The type of related object. Values are Table and View.
Related Object Name

The name of the object. Click on this name hyperlink to go to the object.
Metadata UID

Unique ID of the related object.
Creation Time

The time and date when the related object was created.
Redefinition Time

The time and date when the related object was last redefined.

View related privileges
Grantee

The name of the user whose privilege is described.
Grantor

The name of the user that granted the privileges or the special SQL user names PUBLIC
and SYSTEM.

With Grant
Indicates whether the user has grant privileges.

Grant Level
The level at which the permissions are visible. The grant levels are:
Schema

Indicates permissions have been applied to the schema.
Object

Indicates permissions are applied directly to the object whose permissions are being
displayed.

Column
Indicates the permissions applied to the column. If the object level privilege applies to all
columns, individual column privileges are not displayed. Otherwise, the individual column
level permissions are displayed.

Privileges
Describes the privilege of the user. The value is a list of granted privileges separated by
commas or ‘All Privileges’. DDL and DML privileges are grouped accordingly.
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Displaying procedures and their properties
To display the schema procedures and their properties:
1. Log on to the MXDM.
2. In the navigation tree pane, click Database.

MXDM displays a list of existing systems.
3. In the navigation tree, expand the contents of the system.

The list of catalogs appears.
4. Expand the contents of a catalog.

The list of schemas appears.
5. Expand the contents of a schema.

The Procedures folder appears.
6. Select a procedure.

In the right pane, the following tabs related to the procedure appear:

• Attributes
• Parameters
• Related Objects
• DDL
• Privileges
Figure 33 (page 96) shows the properties of a procedure.

Figure 33 Procedure properties

Displaying attributes of a procedure
To display the attributes of a procedure:
1. In the navigation tree, select the procedure.
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2. In the right pane, click Attributes.
The following details related to attributes appear:

• Name — The name of the procedure.

• Metadata UID — The unique ID number of the procedure.

• Dynamic Result Sets — The maximum number of result sets returned.

• SQL Access — This attribute specifies how the procedure accesses the SQL data. If
the procedure does not perform SQL operations, the value displayed in this field is N.
Otherwise, the value displayed in this field is one of the following:

◦ CONTAINS SQL

◦ MODIFIES SQL DATA

◦ READS SQL DATA

• Parameters — The parameter type. For information on data types, see HPE NonStop
SQL/MX Guide to Stored Procedures in Java.

• External Path — Either an OSS directory or a JAR file path that contains the SPJ class
file.

• External File — The name of Java class file that contains the procedure code.

• External Name — This attribute specifies the case-sensitive name of the SPJ method.
For more information, see HPE NonStop SQL/MX Release 3.4 Reference Manual.

• Language — The programming language in which the procedure code is written.

• Parameter Style — The programming language associated with the format of the
procedure parameters.

• Deterministic — If in the Create Procedure statement you specified the option
DETERMINISTIC, this column contains Yes. If you specified NOT DETERMINISTIC,
this column contains a No. This value specifies whether the SPJ always returns the
same values for OUT and INOUT parameters for a given set of argument values
(DETERMINISTIC) or does not return the same values (NOT DETERMINISTIC, which
is the default option). SQL/MX allows both options but always treats the SPJ as
nondeterministic.

• Isolate — This attribute specifies that the SPJ executes either in the environment of
the database server (NO ISOLATE) or in an isolated environment (ISOLATE, which is
the default option). SQL/MX allows both options but always executes the SPJ in the
SQL/MX user-defined routine (UDR) server process (ISOLATE).

• Transaction Attributes — This attribute indicates whether a transaction is required.

• Creation Time — The time and date when the procedure was created. The time and
date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the procedure was last redefined. The
time and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying parameters of a procedure
To display the parameters of a procedure:
1. In the navigation tree, select the procedure.
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2. In the right pane, click Parameters.
The following details related to parameters appear:

• Name — The name of the parameter.

• Direction — The following values appear:

◦ IN — Passes data to the procedure.

◦ OUT — Accepts data from the procedure. This value is the default for array
parameters.

◦ INOUT — Passes data to and accepts data from the procedure.

• SQL Data Type — This attribute specifies an SQL data type that corresponds to the
Java parameter of the procedure's Java method. For information on SQL data types,
see HPE NonStop SQL/MX Release 3.4 Reference Manual.

• Java Data Type — This attribute specifies a Java data type that can be mapped. For
information on Java data types, see HPE NonStop SQL/MX Release 3.4 Reference
Manual.

Displaying information on related objects
To display information on related objects:
1. In the navigation tree, select the view.
2. In the right pane, click Related Objects.

The following details appear:

• Relationship— This attribute specifies the relationship of the procedure with the object
specified. The available value for this field is References, Used By, and Has.

• Related Object Type— This attribute specifies the type of the object that the procedure
references. The available value is Table or View.

• Related Object Name — This attribute specifies the three-part ANSI object name. The
object name is linked to the object.

• Metadata UID — A unique ID of the related object.

• Creation Time — The time and date when the related object was created. The time
and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

• Redefinition Time — The time and date when the related object was last redefined.
The time and date are expressed in the yyyy-MM-dd HH:mm:ss.FFFFFF format.

Displaying DDL information of a procedure
To display DDL information related to the procedure:
1. In the navigation tree, select the procedure.
2. In the right pane, click DDL.

The DDL tab displays the SHOWDDL output for the procedure. For more information on the
SHOWDDL command, see HPE NonStop SQL/MX Release 3.4 Reference Manual.

Displaying information related to procedure privileges
To display information related to the procedure privileges:
1. In the navigation tree, select the procedure.
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2. In the right pane, click Privileges.
The following details related to the procedure privileges appear:

• Grantee — The name of the user whose privilege is described.

• Grantor — The name of the user who granted the privileges and the special SQL user
names PUBLIC and SYSTEM.

• With Grant — This attribute indicates whether the user has grant privileges.

• Grant Level — The level at which the permissions are visible. The column displays
the schema, object, and column values.

◦ Schema — This attribute indicates that permissions are applied to the schema.

◦ Object — This attribute indicates that permissions were applied directly to the
object whose permissions are displayed.

◦ Column — This attribute indicates that permissions are applied to the column.
When an object-level privilege applies to all columns, the individual column privileges
do not appear. Otherwise, the individual column permissions appear.

• Privileges — This attribute describes the privilege of the user. The value is Execute.
DDL and DML privileges are grouped accordingly. For the list of privileges, see HPE
NonStop SQL/MX Release 3.4 Reference Manual.

Granting privileges on a procedure
You can grant only execute privilege on a procedure to specific users.
1. Log on to the NonStop SQL/MX Database Manager.

To grant privilege on a procedure, you must be the owner of the procedure, the security
administrator, a user with grant privileges, or log in as SUPER.SUPER user if the Security
Administrator group is empty.

2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems
→Catalogs→Schemas.

3. Expand Procedures folder (left pane) and select the procedure on which you want to revoke
privileges.

4. Right-click and select Grant/Revoke Privileges.
The Grant/Revoke Privileges options appear in the right pane. The Grant option is selected
by default.
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Figure 34 Grant/Revoke Privileges

5. In the Grantees section, select Public to grant privileges to all users in the system.
Or, select Specified Users to grant privileges to specific users in the system.
If the Specified Users option is selected, then the user grid is enabled. Press Ctrl and click
on the desired user names to select users.
In the Privileges section, the Execute option is selected and disabled. This indicates that
the only privilege that can be granted on a procedure is execute.

6. Optional. Select By User and select the user name in the corresponding drop-down menu
to grant privileges on behalf of another user.

7. Optional. Select With Grant Option to grant the privileges and allow the grantees to grant
the privileges to other users.

8. Click Grant.

Revoking privileges on a procedure
You can revoke only execute privilege on a procedure from specific users.
1. Log on to the NonStop SQL/MX Database Manager.

To revoke privilege on a procedure, you must be the security administrator, a user with grant
privileges, or log in as SUPER.SUPER user if the Security Administrator group is empty.

2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems
→Catalogs→Schemas.

3. Expand Procedures folder (left pane) and select the procedure on which you want to revoke
privileges.
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4. Right-click and select Grant/Revoke Privileges.
The grant/revoke privileges options appear in the right pane.

5. Select Revoke option to revoke privileges.
6. Optional. Select Grant Option For to revoke the With Grant Option for the privilege and not

the privilege itself.
7. Select Public option in Grantees section to revoke privileges from all users in the system.

Or, select Specified Users option in Grantees section to revoke privileges from specific
users in the system.
If Specified Users option is selected, the user grid is enabled. Press Ctrl and click on the
desired user names to select users.
In the Privileges section, the Execute option is selected and disabled. This indicates that
the only privilege that can be revoked on a procedure is execute.

8. Optional. SelectBy User option and select the user name in the corresponding list to revoke
privileges on behalf of another user.
Select Cascade option to revoke dependent privilege descriptors and objects.

9. Click Revoke.

Managing SQL/MP aliases
SQL/MP aliases

SQL/MP aliases are simulated ANSI names that represent the underlying Guardian physical
names of SQL/MP objects. True ANSI names do not exist for SQL/MP objects. In SQL/MX
Release 2.x and later versions, you can create SQL/MP aliases that map logical object names
to physical Guardian locations. For information on SQL/MP aliases, see HPE NonStop SQL/MX
Release 3.4 Reference Manual.
You can create, alter, drop, and view an SQL/MP alias from MXDM.

Managing SQL/MP aliases and their properties
You can perform the following operations on SQL/MP aliases from MXDM:
• Creating an SQL/MP alias

• Altering an SQL/MP alias

• Dropping an SQL/MP alias

• Viewing SQL/MP alias properties

Prerequisites

• To create an SQL/MP alias, you must be the owner of the schema that contains the SQL/MP
alias or log in as SUPER.SUPER user.

• To alter and drop an SQL/MP alias, you must be the owner of the SQL/MP alias, the owner
of the schema that contains the SQL/MP alias, or log in as SUPER.SUPER user.

Creating an SQL/MP alias
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to the SQL/MP Aliases folder by expanding Database→My

Systems→Catalogs→Schemas→SQL/MP Aliases.
3. Right-click on the SQL/MP Aliases folder and select Create SQL/MP Alias.

The Create SQL/MP Alias wizard appears.
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The SQL/MP alias is created in the schema from where you launched the Create SQL/MP
Alias wizard. To create the alias in a different catalog or schema, select another catalog
and schema from the list.

4. In the General Properties tab, enter the name of the SQL/MP alias to be created.
5. In the SQL/MP Target tab:

• Select a NonStop system name from the System drop-down.

• Select a volume, subvolume, and a file which is the guardian physical name of a table,
view, or partition by expanding the navigation tree.
The Location text box gets populated with the path you selected. This text box is
read-only.

6. Click Create.
The new SQL/MP alias appears in the SQL/MP Aliases folder if the operation is successful.

Altering an SQL/MP alias
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Expand the SQL/MP Aliases folder and select the alias name you want to alter.
4. Right-click and select Alter SQL/MP Alias.

The Alter SQL/MP Alias dialog box appears.
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5. Select the required system name in the System drop-down.
The SQL/MP Target navigation tree is populated with volume, subvolume, and file names
based on the selected system.

6. Select the required volume, subvolume, and file name in the SQL/MP Target navigation
tree.
The Location text box is populated with the path selected in the SQL/MP Target tree.

7. Click OK.

Dropping an SQL/MP alias
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand the SQL/MP Aliases folder and select the alias name you want to remove.
4. Right-click and select Drop SQL/MP Alias.

The Confirm Drop SQL/MP Alias dialog box appears.
5. Click Yes to drop the alias.

Viewing SQL/MP alias properties
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand SQL/MP Aliases folder and select an SQL/MP alias.

The right pane displays the following tabs:
• SQL/MP alias attributes displays the attributes information for the SQL/MP alias.

• DDL displays the SQL/MX statement used to create the SQL/MP alias.

SQL/MP alias attributes
Name

The name of the SQL/MP alias.
Metadata UID

The unique ID number of the SQL/MP alias.
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SQL/MP Target
The Guardian location of the SQL/MP table or view associated with the alias.

Managing sequence generators
Sequence generators

A sequence generator is a database object that generates unique sequential values. For example,
you can use sequence generators to generate primary key values. After a number is generated,
the sequence is incremented for ascending sequence and decremented for descending sequence.
For information on sequence generators, see HPE NonStop SQL/MX Release 3.4 Reference
Manual.
You can create, alter, rename, drop, and display sequence generator properties from MXDM.

Managing sequence generators and their properties
You can perform the following operations on sequence generators from MXDM:
• Creating a sequence generator

• Altering a sequence generator

• Renaming a sequence generator

• Dropping a sequence generator

• Viewing sequence generator properties

• Granting privileges on a sequence generator

• Revoking privileges on a sequence generator

Prerequisites

• To create a sequence generator, log in as the owner of the schema that contains the
sequence generator or as SUPER.SUPER user.

• To alter, rename, and drop a sequence generator, log in as the owner of the sequence
generator, the owner of the schema that contains the sequence generator, or as
SUPER.SUPER user.

• To grant a privilege on a sequence generator, log in as the owner of the sequence generator,
the security administrator, a user with grant privileges, or as SUPER.SUPER user if the
Security Administrator group is empty.

• To revoke a privilege on a sequence generator, log in as the owner of the sequence generator,
the security administrator, or log in as SUPER.SUPER user if the Security Administrator group
is empty.

Creating a sequence generator
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Right-click on the Sequences folder and select Create Sequence.

The Create Sequence wizard appears.
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Figure 35 Create Sequence wizard

The sequence generator is created in the schema from where the Create Sequence wizard
is launched. To create a sequence generator in a different catalog or schema, select another
catalog and schema from the navigation tree displayed in the Schema section in theGeneral
Properties tab.

4. Click General Properties tab.
• Enter the name of the sequence in the Name box.

• Set the following attributes as desired:

Data Type
The supported data types are numeric, integer, large integer, and small integer.

◦

◦ Unsigned

◦ Precision
The Precision option is displayed if you select Numeric in Data Type.

◦ Start With

◦ Increment By

◦ Minimum Value

◦ Maximum Value

◦ No Cycle/Cycle
For more information, see Sequence generator attributes.
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5. In the Location tab, select the system and volume name where the sequence generator
must reside.
You can let SQL/MX determine the name of the physical file for the sequence generator or
enter the file name in the text box in the File Name section. This option is enabled after you
select the system and volume name.

6. Click Create.

Altering a sequence generator
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Expand Sequences folder (left pane) or click the Sequences tab (right pane), and select

the sequence generator you want to alter.
4. Right-click and select Alter Sequence.

The Alter Sequence dialog box appears.

Figure 36 Alter Sequence dialog box

5. Select the check box corresponding to an option to enable it.
You can alter any of the following attributes:
• Increment By
• Min Value
• Max Value
• Cycle
• Restart With
This attribute resets the current value with the user specified value. If this option is selected,
the other options cannot be selected. Restart With is available only for alter sequence
operation.
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For more information, see Sequence generator attributes.
6. Click OK.

NOTE: Altering a sequence generator attribute changes the redefinition timestamp for the
sequence generator. As a result, the similarity checks fail during runtime for applications that
use altered sequence generators, and therefore applications are recompiled. To avoid this, HPE
recommends you to recompile all the applications using the sequence generator after altering
the attributes.

Renaming a sequence generator
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to theSchemas folder by expandingDatabase→MySystems

→Catalogs→Schemas.
3. Expand the Sequences folder (left pane) or click the Sequences tab (right pane), and select

the sequence generator you want to rename.
4. Right-click and select Rename Sequence.

The Rename Sequence dialog box appears.
5. Enter the name for the sequence generator in the New Sequence Name field and click OK.

NOTE: Renaming a sequence generator changes the ANSI name and the redefinition timestamp
for the sequence generator. As a result, the similarity checks fail during runtime for applications
that use altered sequence generators, and therefore applications are recompiled. To avoid this,
HPE recommends you to recompile all the applications using the sequence generator after
renaming the sequence generator.

Dropping a sequence generator
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand Sequences folder (left pane) or click the Sequences tab (right pane), and select

the sequence generator you want to remove.
4. Right-click and select Drop Sequence.

The Confirm Drop Sequence dialog box appears.
5. Select Restrict or Cascade option.

• If you select Restrict option and there are one or more triggers that reference the
selected sequence generator, then the sequence is not dropped. And an error message
is displayed.

• If you select Cascade option and there are one or more triggers that reference the
selected sequence generator, then the selected sequence generator and related triggers
are dropped.

6. Click Yes.

Granting privileges on a sequence generator
You can grant usage privileges on a selected sequence generator to specific users.
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand Sequences folder (left pane) or click the Sequences tab (right pane), and select

the sequence generator on which you want to grant privileges.
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4. Right-click and select Grant/Revoke Privileges.
The grant/revoke privileges options appear in the right pane. The Grant option is selected
by default.

Figure 37 Grant/revoke privileges

5. In the Grantees section, select Public to grant privileges to all users.
Or, select Specified Users option to grant privileges to specific users.
If Specified Users option is selected, the user grid is enabled.
In the Privileges section, the Usage option is selected and disabled. This indicates that the
only privilege that can be granted on a sequence generator is usage.

6. Optional. In the user grid, press Ctrl and click on the desired user names to select users.
7. Optional. Select By User option and select the user name in the corresponding drop-down

menu to grant privileges to that user.
8. Optional. Select With Grant Option to grant the privileges and allow the grantees to grant

the privileges to other users.
9. Click Grant.

Revoking privileges on a sequence generator
You can revoke usage privileges on a selected sequence generator from specific users.
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1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand Sequences folder (left pane) or click the Sequences tab (right pane), and select

the sequence generator on which you want to revoke privileges.
4. Right-click and select Grant/Revoke Privileges.

The grant/revoke privileges options appear in the right pane. The Grant option is selected
by default.

5. Select Revoke to revoke privileges.
6. Optional. Select Grant Option For to revoke the With Grant Option for the privilege and

not the privilege itself.
7. In the Grantees section, select Public to revoke privileges from all users.

Or, select Specified Users option in Grantees box to revoke privileges from specific users.
If Specified Users option is selected, the user grid is enabled.
In the Privileges section, the Usage option is selected and disabled. This indicates that the
only privilege that can be revoked on a sequence generator is usage.

8. Optional. In the user grid, press Ctrl and click on the desired user names to select users.
9. Optional. Select By User option and select the user name in the corresponding combo box

to revoke privileges on behalf of another user.
Select Cascade option to revoke dependent privilege descriptors and objects.

10. Click Revoke.

Viewing sequence generator properties
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to Schemas folder by expanding Database→My Systems

→Catalogs→Schemas.
3. Expand Sequences folder and select a sequence generator.

The right pane displays the following tabs:
• The Sequence generator attributes tab displays the attributes information for the

sequence generator.
• The DDL displays the SQL/MX statement used to create the sequence.

• The Sequence generator related privileges tab displays the privileges of one or more
users for a sequence generator. It also displays the name of the user who granted the
privileges.
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Sequence generator attributes
Name

The name of the sequence generator.
Metadata UID

A unique ID number of the sequence generator.
Start With

The first sequence number to be generated. This value can be positive or negative.
Increment By

The increment value to be added to the current value to obtain the next value in the sequence.
The default value is 1. This value cannot be 0. This value can be positive or negative.

Min Value
The minimum value for the sequence. The default is the minimum value of the sequence
generator data type. This value must be less than the Max Value and must be more than or
equal to the Start With value. It can be positive or negative.

Max Value
The maximum value for the sequence. The default is the maximum value of the sequence
generator data type. This value must be greater than the Min Value and must be greater
than or equal to the Start With value. It can be positive or negative.

Cycle Option
This attribute determines the behavior of the sequence generator when it reaches either the
maximum or minimum value. The options available are:
Cycle

If this option is specified, the sequence generator loops over to generate the minimum
value after an ascending sequence reaches the maximum value or generate the maximum
value after a descending sequence reaches the minimum value.

No Cycle
If this option is specified, the sequence generator raises an exception if a new value is
requested after an ascending sequence reaches the maximum value or a descending
sequence reaches the minimum value.

Location
This attribute specifies a volume and optionally a node, subvolume, and the filename of the
sequence generator.

Creation Time
The time and date when the sequence generator was created.

Redefinition Time
The time and date when the sequence generator was last redefined.

Sequence generator related privileges
Privileges are provided to specified users for performing actions, such as delete, insert, select,
and update, on SQL/MX objects. MXDM GUI allows users to view the privilege details for
sequences. For the list of privileges on sequence generators, see HPE NonStop SQL/MX
Reference Manual.
Grantee

The name of the user whose privilege is described. A grantee can be PUBLIC.
Grantor

The name of the user who granted the privileges or the special SQL user name SYSTEM. A
grantor cannot be PUBLIC.
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With Grant
Indicates if the user has grant privileges.

Grant Level
The level at which the permissions are visible. The grant levels are:
Schema

Indicates permissions are applied to the schema.
Object

Indicates permissions are applied directly to the object.
Column

Indicates the permissions applied to the column. If the object level privilege applies to all
columns, individual column privileges are not displayed. Otherwise the individual column
level permissions are listed.

Privileges
Describes the privileges granted to the user for a sequence generator. The only privilege that
can be granted or revoked on a sequence generator is usage.

Managing triggers
Triggers

A trigger is a mechanism that resides in the database. Triggers are activated when a particular
insert, delete, or update occurs on a table. SQL/MX performs one or more additional actions
specified in the trigger. You can create, enable or disable, drop, and view trigger properties from
MXDM. For information on triggers, see HPE NonStop SQL/MX Release 3.4 Reference Manual.

Managing triggers and their properties
You can perform the following operations on triggers from MXDM:
• Creating a trigger

• Enabling a trigger

• Disabling a trigger

• Dropping a trigger

• Viewing trigger properties

Prerequisites

• To create a trigger, you must be the owner of the schema that contains the trigger or log in
as SUPER.SUPER user.

• To enable, disable, or drop a trigger, you must be the owner of the trigger, the owner of the
schema that contains the trigger, or log in as SUPER.SUPER user.

Creating a trigger
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate to the Triggers folder by expandingDatabase→My Systems

→Catalogs→Schemas→Tables.
3. Right-click on the table or the Triggers folder and select Create Trigger.

The trigger is created in the schema of the subject table from where you launch the Create
Trigger on Table wizard. To create the trigger in a different catalog or schema, select
another catalog and schema from theCatalog and Schema drop-down menus in the Trigger
Schema section of the General Properties tab. To create the trigger on a different subject
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table, select another table in the navigation tree that appears in the Subject Table section
of General Properties tab. For more information on tables, see Managing tables and their
properties.

Figure 38 Create Trigger

4. Click the General Properties tab and enter the following:
• Name of the trigger in the Name field.

• Select the Catalog and Schema in which the trigger will reside in Trigger Schema
section.

• Select the subject table on which the trigger is to be created in Subject Table section.
5. Click the Attributes tab and enter the following:
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a. Select the desired Activation Time option.
b. Select the desired Granularity option.
c. Select the desired Operation option.
d. If you have selectedUpdate of columns option inOperation, then select columns from

the Columns Available grid and click Add.
The selected columns are moved to the Selected Columns grid.
To remove columns, select columns from theSelected Columns grid and clickRemove.

For more information, see Trigger attributes.
6. Click the Statement and Condition tab and enter the following:

a. Enter New as and Old as values in Referencing section.
The values represent the following:
• For Row triggers, the correlation name of the old or new row acted upon by the

trigger.
• For Statement triggers, the table alias name of the old or new table acted upon by

the trigger.
b. Enter the SQL statement in the Triggered Statement text box.
c. Enter the condition that activates the trigger in the Search Condition text box.

7. Optional. Click Preview.
The DDL statement is displayed in the Preview tab. MXDM displays an error message if
any required information is missing or invalid in other tabs. You cannot enter any information
in this tab.

8. Click Create.
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Enabling a trigger
1. Log on to the NonStop SQL/MX Database Manager.
2. Select a table by clicking Database→My Systems→Catalogs→Schemas→Tables.
3. Expand the Triggers folder and select the trigger which you want to enable.
4. Right-click and select Enable Trigger.
5. To enable all the triggers on a table, right-click on the table or the Triggers folder for that

table and select Enable All Triggers.

Disabling a trigger
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate toDatabase→MySystems→Catalogs→Schemas→Tables.
3. Expand the Triggers folder and select the trigger which you want to disable.
4. Right-click and select Disable Trigger.
5. Optional. To disable all the triggers on a table, right-click on the table or the Triggers folder

for that table and select Disable All Triggers.

Dropping a trigger
1. Log on to the NonStop SQL/MX Database Manager.
2. In the navigation tree, navigate toDatabase→MySystems→Catalogs→Schemas→Tables.
3. Expand the Triggers folder and select the trigger which you want to drop.
4. Right-click and select Drop Trigger.

The Confirm Drop Trigger dialog box appears.
5. Click Yes.

Viewing trigger properties
1. Log on to the NonStop SQL/MX Database Manager.
2. Select a table by clicking Database→My Systems→Catalogs→Schemas→Tables.
3. Expand the contents of the table.

The Triggers folder appears.
4. Expand the Triggers folder and select the required trigger.
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Figure 39 Trigger properties

5. The following information appears in the right pane:
• The Trigger attributes tab displays the attributes information for the trigger.

• The Trigger related objects displays the related objects information for the trigger.

• The DDL tab displays the SQL/MX statement used to create the trigger.

Trigger attributes
Name

The name of the trigger.
Metadata UID

Trigger unique ID.
Is Enabled

Indicates whether the trigger is enabled. Values are Yes and No.
Activation Time

Specifies when the trigger is activated. Values are Before and After. The trigger is activated
before or after the operation.

Operation
Trigger is activated for the specified operation. Values are Update of Columns, Insert, Delete,
and Update. Update indicates an update operation on all the columns. Update of columns
indicates an update operation on the selected columns.

Granularity
Indicates the trigger type. Triggers can be Row triggers or Statement triggers. Row triggers
can be activated Before or After any operation. Statement triggers are activated after any
operation.

Creation Time
The time and date when the trigger is created.

Redefinition Time
The time and date when the trigger is redefined.
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Trigger related objects
Triggers are activated before or after operations. They are performed on database objects like
tables or views. MXDM displays the following information for database objects associated with
a trigger:
Relationship

Specifies the relationship between the trigger and the object.
Related Object Type

The type of the related object. The values are Table, View, Procedure, and Sequence.
Related Object Name

The name of the object. It is a hyperlink.
Metadata UID

Related object unique ID.
Creation Time

The time and date when the related object was created.
Redefinition Time

The time and date when the related object was redefined.
Operation

Specifies the operations to be performed on the object to activate the trigger. Values are
Update of Columns, Insert, Delete, and Update. Update indicates an update operation on all
the columns. Update of columns indicates an update operation on selected columns.

Is Subject Table
Specifies if the object values are true or false.

Refreshing database objects to get the current status
The status of a database object displayed in MXDM may not be the same as its status in the
server since another tool (like MXCI) might have modified it. To know the current status, user
must either select Refresh on the object or on one of its ancestors. This applies to all database
objects.
To perform a refresh operation:
1. In the navigation tree, select the database object.
2. Right-click and select Refresh.

Managing objects using the SHOW DDL option
The SHOW DDL option enables you to view the DDL statements of multiple objects in a schema.
To use the SHOW DDL option for an object, right-click any object within the Schemas folder in
the navigation tree, and select SHOW DDL.
Figure 40 (page 117) shows the SHOW DDL dialog.
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Figure 40 SHOW DDL dialog

NOTE: The SHOW DDL option is available only for a schema node and its child nodes in the
navigation tree. The SHOW DDL option is not available for catalogs and the Schemas folder.

In the SHOW DDL dialog, the Select Objects pane displays the list of systems and the objects
that they contain. You can select these objects.
If you select the SHOW DDL option on a folder node in the main navigation tree, the Select
Objects pane displays the navigation tree with the corresponding folder node and all its child
nodes selected. If you invoke the SHOW DDL option on a leaf node in the main navigation tree,
the Select Objects pane displays the navigation tree with the corresponding leaf node selected.
You can select objects from only one schema. If you select objects from different schemas, an
error message appears.
Table 23 (page 117) describes the options in the SHOW DDL dialog.

Table 23 SHOW DDL options

DescriptionOption

Loads the SHOW DDL output of the selected objects and replaces the contents in the
DDL Output pane.

Load

Appends the selected objects to the existing contents in the DDL Output pane.Append

Clears the check boxes against the selected objects in the Selected Objects pane.Clear All

Clears the DDL Output field.Clear

Saves the contents of the DDL Output field using the File menu dialog.Save

Closes the SHOW DDL dialog.Close

Displaying table statistics and their properties
MXDM enables you to view the table statistics. You can use the table statistics to troubleshoot
and to create additional indexes. To view table statistics, the default catalog
(NONSTOP_SYSTEM_NSK) and the default schema (PUBLIC_ACCESS_SCHEMA) are required. If
the default catalog and schema are not available, table statistics are not displayed. For information
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on creating the default catalog and schema, see HPE NonStop SQL/MX Connectivity Service
Manual for SQL/MX Release 3.4.
To display information related to table statistics:
1. Log on to the MXDM.
2. In the navigation tree pane, click Database.

MXDM displays a list of existing systems.
3. In the navigation tree, expand the contents of the system.

The list of catalogs appears.
4. Expand the contents of a catalog.

The list of schemas appears.
5. Expand the contents of a schema.

The Tables folder appears.
6. Select a table.
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7. In the right pane, click Statistics.
The following histogram statistics for the table appear:

• Column Name — The name of the column.

• Data Type — This attribute specifies the column data type.

• # Nulls — The number of null values for the column.

• Min Value — The minimum value of the column.

• Max Value — The maximum value of the column.

• Skew — The CV entry in HISTOGRAMS table for the column.

• UEC — The TOTAL_UEC (Unique Entry Count) entry from HISTOGRAMS table for the
column.

• Cardinality — The ROWCOUNT entry from HISTOGRAMS table for the column.

• Last Stats Timestamp — The STATS_TIME from HISTOGRAMS table for the column.

NOTE: The Statistics tab includes information only if the table statistics are generated.
To generate the table statistics, you must execute the Update Statistics statement on
the table.

Figure 41 (page 119) shows the table statistics.

Figure 41 Table statistics

For more information on the HISTOGRAMS table, see HPE NonStop SQL/MX Release 3.4
Reference Manual.
To display a sample view of the table column statistics, click the column name, double-click any
row in the right pane, or click View Sampled Column Statistics located at the top right pane.
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The top pane displays the column name, table name, the percentage sampled, and the time
when the sample was taken.
The following details appear:

• Data Type — Displays the column data type.

• # Nulls — The number of null values for the column.

• Skew — The CV entry from HISTOGRAMS table for this column.
The middle pane displays the ten most frequent values for the column. The value itself and its
cardinality (number of occurrences) appear.
The bottom pane displays the following histogram intervals for the column data boundaries:

• Interval Number— The INTERVAL_NUMBER entry from the HISTOGRAM_INTERVALS table.

• Min Boundary — The minimum value for the interval, for the column.

• Max Boundary — The maximum value for the interval, for the column.

• Stats UEC — The TOTAL_UEC entry from the HISTOGRAMS table for the column.

• Sampled UEC — The INTERVAL_UEC from the HISTOGRAM_INTERVALS table.

• Stats Cardinality — The ROWCOUNT from the HISTOGRAMS table for the column.

• Sampled Cardinality — The INTERVAL_ROWCOUNT from the HISTOGRAMS_INTERVALS
table for this column.

The diagram at the bottom right relates the Sampled Cardinality to the Interval Number from the
Intervals table located at the left of the diagram.
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7 Managing MXCS objects
This chapter discusses the following topics:

• “Displaying MXCS servers” (page 121)

• “Stopping an MXCS server” (page 122)

• “Displaying MXCS Services” (page 123)

• “Starting up an MXCS service” (page 124)

• “Stopping an MXCS service” (page 125)

• “Displaying data sources” (page 125)

• “Creating a data source” (page 127)

• “Copying a data source” (page 134)

• “Starting up a data source” (page 135)

• “Stopping a data source” (page 135)

• “Updating a data source” (page 136)

• “Deleting a data source” (page 136)

• “Starting and stopping server traces” (page 137)

• “Displaying MXCS user permissions” (page 137)

• “Adding an MXCS user” (page 138)

• “Editing MXCS user permissions” (page 139)

• “Deleting an MXCS user” (page 139)

• “Refreshing MXCS objects to get the current status” (page 140)

NOTE:
• Any user can view information related to MXCS objects. However, only users with

OPERATOR permission can perform management tasks, such as starting and stopping
MXCS services and MXCS servers.

• All users can view all data sources. Only MXCS users with OPERATOR permission can
perform management tasks on a data source.

Displaying MXCS servers
To display all MXCS servers for a system:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Expand a system, and click MXCS Services.
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4. In the right pane, click MXCS Server Status.
The list of MXCS servers and their status appear.
Figure 42 (page 122) shows the MXCS servers and their status.

Figure 42 MXCS Servers Status

Table 24 (page 122) describes the fields in the MXCS Server Status tab.

Table 24 MXCS Server Status fields

DescriptionField

The operating system process name of the server.Process Name

The MXCS service to which the process belongs.Service Name

The user-defined name of the data source. A data source is a data structure
that contains connection information such as CQDs, SETS, and Controls. The
ODBC/MX driver uses this information to connect to the database.

Data Source Name

The current state of the server, such as Available and Connected.State

The process ID of the client connected to the server. If there is no connection,
the value is set to 0.

PID Client

The name of the client application connected to the server. If there is no
connection, the field is blank.

Application Name

The name of the user connected to the server. If there is no connection, the
field is blank.

User Name

The system name where the client application is running. If there is no
connection, the field is blank.

Computer Name

CPU number where the server is running.CPU

The operating system process ID assigned to the server.Server PIN

The port number and object reference information for the service.Port

The date and time of the last update to the server's state.Last Updated Time

Term
MXCS server

Stopping an MXCS server
To stop an MXCS server:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.
3. Expand the system that contains the MXCS servers that you want to stop.
4. Click MXCS Services.
5. In the right pane, click MXCS Server Status to display the list of MXCS servers.
6. Select the server that you want to stop. You can select more than one server.
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7. Click Stop
The Stopping Server dialog appears.

8. Click Stop Immediately.
The MXCS server stops.

CAUTION: Stop Immediately stops the server without waiting to finish any current
database statements or server processes. The transaction manager rolls back all uncommitted
transactions held by these MXCS servers. All client connections are closed.

NOTE: After you click a stop option, you cannot cancel the operation.

Terms
operator permission
MXCS server

Displaying MXCS Services
Any user can view MXCS services. To display all MXCS services for a system:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.
3. In the navigation tree pane, expand the system that contains the MXCS services.
4. Click MXCS Services.

Displaying MXCS Services 123



5. In the right pane, clickMXCS Services to display details of the Association and Configuration
servers.
Figure 43 (page 124) show the properties related to MXCS Services.

Figure 43 MXCS Services tab

Table 25 (page 124) describes the fields in the MXCS Services tab.

Table 25 MXCS Services fields

DescriptionField

The MXCS service to which the process belongs.Service Name

Association server or Configuration server.
Association Servers (MXOAS) are persistent processes. MXOAS
provides database connectivity to client applications. They spawn MXCS
server processes, which handle database requests from clients. MXCS
server processes execute the database queries for the clients. They
can spawn Executor Server Processes (ESPs) to achieve parallelism
in the execution of queries. Configuration Servers (MXOCFG) manage
the MXCS configuration data. For more information on MXOAS, see
HPE NonStop SQL/MX Connectivity Service Manual for SQL/MX
Release 3.3.

Service Type

The operating system process name of the server.Process Name

The current state of the service.State

CPU number where the server is running.CPU

The operating system process ID assigned to the component.Server PIN

The port number and object reference information for the service.Port

The date and time of the last update of the service state.Last Updated Time

Starting up an MXCS service
Starting up an MXCS service changes the state of the service from Stopped to Available.
To start up an MXCS service:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.
3. In the navigation tree pane, select the system that contains the MXCS services.
4. In the navigation tree pane, expand the MXCS Services folder for the system.
5. Right-click the name of the service that you want to start up, and select Start.

The MXCS service starts.
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This action enables the MXCS service and the following components:
• Association server

• Configuration server

• Data sources configured with the automatic startup option
If the MXCS service state does not change to the Available state, contact the Hewlett Packard
Enterprise Support Center.
Related Topic
Terms
operator permission
Association server
Configuration server
Data sources
MXCS service

Stopping an MXCS service
When you stop an MXCS service, the configuration server remains Available, but the association
server changes from the Available state to the Stopped state. This operation effectively stops
any data source that is currently started.
To stop an MXCS service:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.
3. In the navigation tree pane, select the system that contains the MXCS services.
4. In the navigation tree pane, expand the MXCS Services folder for the system.
5. Right-click the name of the service that you want to stop, and select Stop

The Stopping Service dialog appears.
6. Enter a reason for stopping the service.
7. Click one of the following options:

NOTE: After you click a stop option, you cannot cancel the operation.

• Stop on Client Disconnect
• Stop Immediately

CAUTION: Stop Immediately disables the MXCS service without waiting for the
MXCS servers to finish current operations. The transaction manager rolls back all
uncommitted transactions held by these MXCS servers. All client connections are closed.

The MXCS service stops.

Terms
operator permission
association server

Displaying data sources
To display data sources:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
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3. Expand the system and click the Data Sources folder.
Figure 44 (page 126) shows the data sources in the navigation tree. The right pane displays
the details corresponding to the data sources.

Figure 44 Data sources

The Data Sources tab displays the following data source properties:
• Data Source Name — The name of the data source.

• Maximum — The upper limit of the servers that can be operational for the service on
this data source.

• Idle — The lower limit of the available idle servers that are operational for the service
on this data source. This value represents idle servers that are waiting for user
connections.

• Initial — The suggested number of servers that each service starts when the data
source is first started.
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4. In the navigation tree pane, click a data source. In the right pane, the properties in the Data
Source Status tab appear.
Figure 45 (page 127) shows the properties in the Data Source Status tab.

Figure 45 Properties in the Data Source Status tab

In the right pane, the following details related to the data source appear:

• Data Source Name — The name of the data source.

• Service Name — The MXCS service to which the process belongs.

• State — The current state of the data source.

• Tracing — The current state of server tracing.

• Total: — The total number of servers running.

• Connected — The number of servers connected to clients.

• Maximum — The upper limit of the servers that can be operational for the service on
this data source.

• Idle — The lower limit of the available idle servers that are operational for the service
on this data source. This value represents idle servers that are waiting for user
connections.

• Initial — The number of servers that each service starts when the data source is first
started.

• Last State Changed— The date and time when the data source state was last updated.

Term
data source

Creating a data source
To create a data source:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Expand the system for which you want to create a new data source.
4. Right-click Data Sources, and select Create Data Source

The Create Data Source window appears.
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5. Configure the data source properties, as described in:
• “Using General Properties” (page 128).

• “Using the DEFINEs and SETs tab” (page 130)

• “Using the Control Query Defaults tab” (page 132)

• “Using the Control Table Statements tab” (page 133)

NOTE:
Some tabs provide tooltips that explain the use of an option or the range of values supported
for a field. Figure 46 (page 128) shows a tool tip for one of the fields.

Figure 46 Tooltip in tabs

6. After configuring the data source properties, click Create.
7. Refresh the navigation tree pane.

The new data source appears.
8. To start up the data source, see “Starting up a data source” (page 135).
Terms
data source
navigation tree pane

Using General Properties
Table 26 (page 128) describes the properties displayed in the General Properties tab.

Table 26 General Properties options

DescriptionOptionGroup

You must assign a unique name for the new data source. The name can
be a maximum of 128 characters (any characters) without leading or

NameData Source
Name

trailing spaces. Leading or trailing spaces are automatically removed
before the name is sent to the server. The name in lowercase, containing
embedded spaces or quotes is delimited by MXDM.

Enter the name of the required service which you want to associate with
the server data source. To enter multiple services, enter the service
names separated by a space.

NameMXCS Services
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Table 26 General Properties options (continued)

DescriptionOptionGroup

Or, click browse icon. The AddMXCS Services window appears. Select
the names of the services which you want to associate with a data source
and click OK.

Specifies that MXCS automatically starts up the initial MXCS servers for
the data source when the MXCS service is started.

AutomaticStart Mode

You must manually start up the MXCS servers for the data source when
the MXCS service is in the Started state. This value is the default.

Manual

Specifies the number of minutes that an MXCS server remains idle before
it stops. This timeout occurs only under the following conditions:

Server Idle TimeoutPerformance

• The idle server is not connected to a client.

• The number of servers exceeds the number of idle servers configured
for the data source.

The system default is 600 seconds. You can assign a value between 1
and 2,147,483,647.

Specifies the number of minutes that a client-server connection remains
idle before the MXCS server terminates the connection.

Connection Idle
Timeout

You must assign a value between 1 and 2,147,483,647. The system
default is 600 seconds.

You must select this option to collect statistics about the connection and
the session. Data source statistics are stored in the Event Monitoring
Service (EMS) log. The event ID is 21035.

Connection
Information

Session
Statistics

You must select this option to collect statistics about individual SQL
statements. Data source statistics are stored in the EMS log. The event
ID is 21035.

Session Summary

Specifies the upper limit of the servers that can be operational for a
service on the data source.

MaximumNumber of
Servers

The default is 1. The range is 0 to 32767.
0 specifies the system default that is determined by the system at run
time.
If you use the default of 1000 ports for MXCS during installation, the
range is 1 through 997.
If you configure more than 1000 ports for MXCS, the value for Maximum
is the number of configured ports minus 3. In this case, the actual
maximum number of MXCS servers can sometimes be greater than the
number of ports configured.

Specifies the lower limit of the available idle MXCS servers that are
operational for a service on the data source.

Idle

The values range from 0 to 32767. The default is 0.
This value cannot exceed the maximum server value.

CAUTION: The sum of all the Idle values for a given system must not
exceed the number of ports specified when the MXCS service was started
up.

Specifies the suggested number of MXCS servers that each service starts
up when the data source is first started up.

Initial

The default is 0. The values range from 0 to 32767. This value cannot
exceed the maximum server value.

Specifies the priority assigned to a process started for this data source.
The values range from 1 to 199.

InitialProcess Priority
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Table 26 General Properties options (continued)

DescriptionOptionGroup

Specifies the priority of the MXOAS process when the servers are created.System Default

Specifies the processing nodes (CPUs) you want to use for this data
source.

CPU OrderCPU Utilization

Enter a list of CPU numbers, separated by commas. For example:
1,2,4,5,15.

Specifies that the SQL/MX software determines the CPU utilization
automatically.

System Default

Specifies the statistics about individual SQL statements.SQL StatementStatement
Statistics

Specifies the statistics about SQLExecute.SQLExecute

Specifies the statistics about SQLPrepare.SQLPrepare

Specifies the statistics about SQLExecDirect.SQLExecDirect

Specifies the statistics about SQLFetch.SQLFetch

See “Adding and modifying the resource management policy” (page 130).AddResource
Management

See “Adding and modifying the resource management policy” (page 130).Modify

Removes the selected resource management policy.Remove

Adding and modifying the resource management policy
The Resource Management field of the Create New Data Source dialog displays each resource
management policy that is currently in effect for a data source. You can add, modify, and remove
a resource management policy for the selected data source.

NOTE: You can enter only one resource management policy for each attribute name.

Table 27 (page 130) describes the fields in the Add and Modify dialogs.

Table 27 Fields in the Add and Modify dialogs

DescriptionField

The name of a resource management policy attribute that limits the execution of user queries
from a client application, based on cost.

Attributes

The action to be taken by MXCS when the limit is exceeded. In all cases, an event message is
sent to the event log. Valid values are:

Action

• LOG — The user query continues execution.

• LOG_WITH_INFO — The user query returns a warning message to the client; the query
execution continues.

• STOP — The user query returns an error message to the client; the query execution stops.

The maximum value for the attribute. This value is any positive number; the maximum is the
value of the LARGEINT SQL data type.

Limit

Enter the details and click OK. The new resource management policy is added to the attribute
list or the currently configured policy is modified. These changes are effective when you
subsequently connect to a server in the data source.

Using the DEFINEs and SETs tab
This section describes the DEFINEs and SETs tabs.
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About DEFINEs
A DEFINE statement is a named set of attribute-value pairs associated with a process. SQL/MX
allows DEFINEs to be used as logical names for tables, views, or partitions in statements that
query SQL/MP objects.
DEFINE statements are stored as part of the configuration data for the data source. They are
retrieved and set by the association server when it reads the startup values for the data source.
Changes become effective the next time a connection is made to a server in the data source.
Table 28 (page 131) describes the fields in the DEFINEs tab.

Table 28 DEFINEs tab buttons

FunctionButton

Displays the Add DEFINE dialog.Add

Displays the Edit DEFINE dialog.Modify

Removes the selected DEFINE statement.Remove

Figure 47 SET SCHEMA Example

About SETs
SET variables affect the behavior of MXCS. For example, you can set default catalog and schema
names for servers running in this data source when they are not set at the client data source.
Client data source values take precedence over server data source values.
SET variables are stored as part of the configuration data for the data source. They are retrieved
by the association server when it reads the startup values for the data source. The data source
server then sets the value when a connection is established.
Table 29 (page 131) describes the SET tab functions.

Table 29 Functions on the SETs Tab

FunctionButton

Displays the Add SET dialog.Add

Displays the Edit SET dialog.Modify

Removes the selected SET variable.Remove

Some SET commands require that you specify a value in single quotes. For example, SET
SESSION commands always require that the value be within single quotes. Figure 48 (page 132)
shows an example of the SET SESSION command.
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Figure 48 SET SESSION example

Internally, MXDM concatenates theName and Value fields to form the SET command. Therefore,
you can specify the value alone in the value field and the rest of the command in the Name field,
as shown in the example. Alternatively, you can specify the type of the SET command in the
Name field and the rest of the command in the Value field. Hewlett Packard Enterprise
recommends that you use this approach. Figure 49 (page 132) shows an example.

Figure 49 SET SCHEMA example

Using the Control Query Defaults tab
To add or modify a CQD configured for a data source:
1. In the navigation tree pane, click Connectivity.
2. Complete the initial steps to create a data source until you see the following shown in

Figure 50 (page 132).

Figure 50 Data source configuration

For information on creating a data source, see “Creating a data source” (page 127) or
“Updating a data source” (page 136))

3. Click Control Query Defaults.
4. Click Add or Modify.
5. In the CQD Name field, enter a new name or change the existing name.
6. In the Value field, enter a new CQD value, or change the current value.

132 Managing MXCS objects



Figure 51 Add CQD

Using the Control Table Statements tab
The Control Table Statements tab allows you to modify certain options for specific tables.
Table 30 (page 133) describes the options.

Table 30 Options in the Control Table Statements tab

DescriptionValue

Specifies name of the table.Name

Determines the result if you attempt to access data with read committed or if you serialize access,
and the data is locked by another user.

If-Locked

Specifies whether to use Multi-dimensional Access Method (MDAM) for subsequently compiled
DML statements that access the index.

MDAM

Specifies the priority for subsequent file system requests to MDAM. MDAM uses the priority to
ensure efficient performance in a mixed workload environment.

Priority

Specifies whether to perform similarity checks for new and previous tables to avoid statement
recompilation. This option applies only to tables. It does not apply to views.

Similarity Check

Determines whether to use table locks for subsequently compiled DML statements that access the
table or view.

Table Lock

Specifies the amount of time allowed to complete file-system requests from the DML operations.
If the time elapses before the file system can grant a request to lock data, the DML statement fails
and SQL/MX returns an error.

Timeout

NOTE: This timeout applies to static operations only.

If-Locked

DescriptionValue

Specifies the value used is the system default setting that exists at the time of execution.<Not Set>

Returns the file-system error 73. For more information on file-system errors, seeHPENonStop SQL/MX
Release 3.4 Messages Manual.

Return

Indicates that SQL/MX waits for another user to release the lock, until the timeout period elapses.Wait
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MDAM

DescriptionValue

The value used is the system default setting that exists at execution.<Not Set>

SQL/MX determines whether to use MDAM.Enable

MDAM is not used.Off

MDAM is used.On

Priority
The possible values are 1 through 9, where 9 is the highest value. You can specify a higher
priority for short-duration OLTP-type requests running with concurrent long-duration query
requests.

CAUTION: Using the highest possible value (9) can interfere with SQL/MX system-level activity.

Similarity check

DescriptionValue

The value used is the system default setting that exists at execution.<Not Set>

SQL/MX recompiles the statement at run time, depending on the outcome of late name resolution,
timestamp comparison, or table redefinition.

Off

SQL/MX performs similarity checks at run time to determine whether the new table is similar to the
previous table. If similar, SQL/MX uses the table without recompilation. Otherwise, the SQL statement
is recompiled with the new table name. This setting is the default.

On

Table Lock

DescriptionValue

The value used is the system default setting that exists at execution.<Not Set>

This value indicates whether to use table locks for the specified table or view.Enable

Table locks are not used.Off

Table locks are used.On

Timeout

DescriptionValue

The value used is the system default setting that exists at execution.<Not Set>

No timeout is specified.No Timeout

Does not wait for a table lock. If the lock cannot be acquired, SQL/MX returns an error.Will Not
Wait

1 through 2147483519 in hundredths of a second.Interval

Copying a data source
If you want to create a data source that is similar to an already-configured data source, you can
use the configured data source as a template for the new data source. This procedure makes a
copy of an existing data source configuration and enables you to modify the copy as needed.
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To make a copy of an existing data source:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Expand the system for which you want to create a new data source.
4. Right-click Data Sources, and select Copy Data Source.

The Copy Data Source window appears.
5. Modify the required fields.

• “Using General Properties” (page 128).

NOTE: You must change the data source name. If you do not change the name,
MXDM returns an error message indicating that the data source already exists.

• “Using the DEFINEs and SETs tab” (page 130)

• “Using the Control Query Defaults tab” (page 132)

• “Using the Control Table Statements tab” (page 133)

NOTE: If you made changes to the values in a tab, but you did not apply the changes,
you can reload the previously stored values on the server by clicking Reload.

6. Click Create.
The new data source is created.

Term
data source

Starting up a data source
When you start up the MXCS service, data sources configured with the automatic startup option
are started up.
To start up a data source:
1. Verify that the Association server for the data source is started up:

a. Check the MXCS Server Status display for the data source by performing the steps in
“Displaying MXCS Services” (page 123).

b. If the Association server is not available, start up the Association server by following
the steps in “Starting up an MXCS service” (page 124)

2. In the navigation tree pane, click the data source that you want to start up.
3. In the right pane, click the Data Source Status tab to display the list of services.
4. Select the row of the Service Name that you want to use with the data source.
5. Click Start.

The data source starts up.

Terms
association server
data source

Stopping a data source
To stop a data source:
1. Log on to the MXDM.
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2. In the navigation tree pane, click Connectivity.
MXDM displays a list of existing systems.

3. Expand the system for which you want to stop a data source.
4. Click MXCS Services.
5. In the right pane, click Data Source Status.
6. Select all of the services in which the data source is configured.
7. Click Stop.

The Stopping Data Source dialog appears.
8. In the Reason field, enter a reason for stopping the data source.
9. Select one of the following options:

NOTE: After you click one of the stop options, you cannot cancel the operation.

• Stop on Client Disconnect
• Stop Immediately

CAUTION: Use Stop Immediately with caution. Stop Immediately stops the data
source without waiting for its associated MXCS servers to finish any current database
statements or sessions. The transaction manager rolls back all uncommitted transactions
held by these MXCS servers. All client connections are closed.

The data source stops.

Updating a data source
To update a data source:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Expand the system for which you want to update a data source.
4. Right-click the data source, and select Edit.

The Configuration tab appears.
5. Modify the required fields.

• “Using General Properties” (page 128).

• “Using the DEFINEs and SETs tab” (page 130)

• “Using the Control Query Defaults tab” (page 132)

• “Using the Control Table Statements tab” (page 133)

NOTE: If you made changes to the values in a tab, but you did not apply the changes,
you can reload the previously stored values on the server by clicking Reload.

6. Click Apply.
The changes are applied.

Deleting a data source
You must stop a data source before deleting it. You cannot delete the default data source,
TDM_Default_DataSource.
To delete a data source:
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1. Stop the data source by performing the steps described in “Stopping a data source” (page 135).
2. In the navigation tree pane, right-click the data source, and select Delete.
3. Click Yes to confirm the deletion.

The data source is deleted.

Term
operator permission

Starting and stopping server traces
Data from server traces is stored in the EMS log. The event ID is 21034.
The tracing facility generates a pair of messages for each function that is traced:
• First message — Contains the input parameters to the function

• Second message — Contains the output from the function
After a trace is enabled for a data source, all servers that can write to the EMS alternate collector
begin writing the input and the output data for each function executed during the trace period.
The following data is collected for each function:
• Session ID

• Component name

• Object reference

• Sequence number

• Input values to the function or output from the function
To start tracing for data sources:
1. In the navigation tree pane, click Connectivity.
2. In the navigation tree pane, expand the system that contains the data sources.
3. Click MXCS Services.
4. In the right pane, click Data Source Status to display the list of services.
5. In the Tracing column, select Tracing for each data source.
6. Click Apply.

Tracing starts for the data sources.

To stop tracing for a data source:
1. In the navigation tree pane, click Connectivity.
2. In the navigation tree pane, expand the system that contains the data sources.
3. Click MXCS Services.
4. In the right pane, click Data Source Status to display the list of services.
5. In the Tracing column, clear Tracing for each data source that you want to stop tracing.
6. Click Apply.

Tracing stops for the data sources.

Related Topic
operator permission

Displaying MXCS user permissions
MXCS permissions define the type of access that a user has to manage MXCS objects on the
SQL/MX database. Only a user with OPERATOR permission can view MXCS permissions.
Initially, only the SUPER.SUPER user has OPERATOR permission.
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The following are basic security rules for MXCS users:

• Only the user who installed SQL/MX (SUPER.SUPER or SUPER.SUPER alias) can manage
the user list.

• Only users with OPERATOR permission can view the user list.

• Users with USER permission cannot manage or view the user list.
Figure 52 (page 138) shows the properties in theMXCSPermissions tab. TheMXCSPermission
tab indicates whether the user has OPERATOR or USER permission.

Figure 52 MXCS Permissions tab

To display the current MXCS users:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Under My Systems, select the system for which you want to view permissions.
4. In the right pane, click MXCS Permissions.

In the right pane, the permissions appear.

Related Topics
“Adding an MXCS user” (page 138)
“Editing MXCS user permissions” (page 139)
“Deleting an MXCS user” (page 139)
Term
operator permission
user permission

Adding an MXCS user
Initially, only the SUPER.SUPER user has the OPERATOR permission.
Only a SUPER.SUPER or an alias of SUPER.SUPER user can add an MXCS user.
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To add an MXCS user:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Under My Systems, select the system for which you want to add an MXCS user.
4. In the right pane, click MXCS Permissions.
5. Click Add.

The Add User dialog appears.
6. Under System Users, select Operator or User.
7. From the System Users grid, select the users that you want to add to the MXCS Users

grid.
8. Click Configure.

The user name is configured, and it appears in the MXCS Users pane.
9. Click Add.

The user is added.

Related Topics
“Displaying MXCS user permissions” (page 137)
“Editing MXCS user permissions” (page 139)
“Deleting an MXCS user” (page 139)
Term
operator permission

Editing MXCS user permissions
Only a SUPER.SUPER user or an alias of the SUPER.SUPER user can edit MXCS user permissions.
To edit MXCS user permission:
1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. UnderMySystems, select the system on which you want to edit the MXCS user permissions.
4. In the right pane, click MXCS Permissions.
5. Select the MXCS users whose permission you want to change, and click Edit

A confirmation dialog appears.
6. Click Yes to confirm.
7. Select the permission type, and click OK.

The MXCS user permissions are modified.

Related Topics
“Displaying MXCS user permissions” (page 137)
“Adding an MXCS user” (page 138)
“Deleting an MXCS user” (page 139)
Term
operator permission

Deleting an MXCS user
Only a SUPER.SUPER user or an alias of the SUPER.SUPER user can delete MXCS user
permissions.
To delete an MXCS user:
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1. Log on to the MXDM.
2. In the navigation tree pane, click Connectivity.

MXDM displays a list of existing systems.
3. Under My Systems, select the system on which you want to delete an MXCS user.
4. In the right pane, click MXCS Permissions.
5. Select the MXCS users, and click Delete.

A confirmation dialog appears.
6. Click Yes to confirm.

The MXCS user is deleted.

Related Topics
“Displaying MXCS user permissions” (page 137)
“Adding an MXCS user” (page 138)
“Editing MXCS user permissions” (page 139)
Term
operator permission

Refreshing MXCS objects to get the current status
The status of an MXCS object displayed in MXDM may not be the same as its status in the server
since another tool (like MACL) might have modified it. To know the current status, user must
either select Refresh on the object or on one of its ancestors. This applies to all MXCS objects.
To perform a refresh operation:
1. In the navigation tree, select the MXCS object.
2. Right-click and select Refresh.
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8 Launching the NonStop SQL/MX Remote Conversational
Interface

This chapter discusses the following topics:

• “Introduction to RMXCI” (page 141)

• “Locating the RMXCI program” (page 141)

• “Launching RMXCI” (page 141)

• “Setting Auto Logon options” (page 142)

Introduction to RMXCI
The SQL/MX database supports a client-based utility, called NonStop SQL/MX Remote
Conversational Interface (RMXCI), which enables you to enter SQL statements interactively, or
from script files in its command-line interface. You can also execute SQL statements to RMXCI
from a Perl or Python program.
For more information on RMXCI, see:

• HPE NonStop SQL/MX Remote Conversational Interface (RMXCI) Guide

• Command-line help within RMXCI
The RMXCI help describes the commands supported in the current operating mode of RMXCI.
Related Topics
“Locating the RMXCI program” (page 141)
“Launching RMXCI” (page 141)
“Setting Auto Logon options” (page 142)

Locating the RMXCI program
MXDM launches RMXCI from its default installation location. If RMXCI is not found in the default
location, you can browse to determine the installation location. After MXDM launches RMXCI,
the location is cached. When required, you can change the location from where RMXCI is
launched.
The MXDM application locates the RMXCI program in the RMXCI default install location. If the
RMXCI program is not found at the default installation location, you can browse for the RMXCI
installation location. After the RMXCI program is located, the location is saved. If you uninstall
RMXCI, you must use the same procedure to locate the RMXCI program again. You can change
the location of the RMXCI program at any time. To change the location, select Tools→Options,
and modify the location.
Related Topics
“Introduction to RMXCI” (page 141)
“Launching RMXCI” (page 141)
“Setting Auto Logon options” (page 142)

Launching RMXCI
To launch RMXCI, use one of the following methods:

• From the MXDM toolbar, click SQL/MX Remote Conversational Interface ( ). For more
information on the MXDM toolbar, see “Using the MXDM toolbar” (page 30).

• Select Tools→SQL/MX Remote Conversational Interface.
The RMXCI window appears. If the Auto Logon option is enabled, you can use the user
credentials of the currently selected SQL/MX database that is connected to log on to RMXCI.
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The data source, catalog, and schema name also are considered while logging on. To set auto
logon properties, see “Setting Auto Logon options” (page 142).
You can launch more than one RMXCI window using the described methods. If you set the Auto
Logon option, the user credentials of the currently selected SQL/MX database that is connected
to log on to RMXCI are used each time.
If you select Tools→SQL/MX Remote Conversational Interface, the RMXCI window appears
with a prompt ready to execute the RMXCI commands. If RMXCI is launched and you are not
logged on to a system, RMXCI does not use the Auto logon option. Instead, RMXCI launches
and prompts you for an IP address and port number, which is the default in RMXCI.
Related Topics
“Introduction to RMXCI” (page 141)
“Locating the RMXCI program” (page 141)
“Setting Auto Logon options” (page 142)

Setting Auto Logon options
To set the RMXCI the Auto Logon option:
1. Perform one of the following:

• From the MXDM toolbar, click ( ).
The Options dialog appears.

• Select Tools→Options
The Options dialog appears.

2. In the left pane of the Options dialog, select SQL/MX Remote Conversational Interface.
3. Enable or disable the Auto Logon option.
You can set the RMXCI prompt options. Table 31 (page 142) describes the RMXCI prompt options.

Table 31 RMXCI prompt options

DescriptionOption

Enables RMXCI auto logon.Auto Logon

Enables you to include the following options when you select Auto Logon:Prompt Options
• User

• Server

• Catalog

• Schema

• Datasource

Enables you to enter a custom prompt in the text field.Custom Prompt

NOTE: If the custom prompt contains spaces, enclose it within double quotes.

Related Topics
“Introduction to RMXCI” (page 141)
“Locating the RMXCI program” (page 141)
“Launching RMXCI” (page 141)
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9 Support and other resources
Accessing Hewlett Packard Enterprise Support

• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:
www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support
Center website:
www.hpe.com/support/hpesc

Information to collect
• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the

product interface. Review your product documentation to identify the recommended software
update method.

• To download product updates, go to either of the following:

Hewlett Packard Enterprise Support Center Get connected with updates page:
www.hpe.com/support/e-updates

◦

◦ Software Depot website:
www.hpe.com/support/softwaredepot

• To view and update your entitlements, and to link your contracts and warranties with your
profile, go to the Hewlett Packard Enterprise Support Center More Information on Access
to Support Materials page:
www.hpe.com/support/AccessToSupportMaterials

IMPORTANT: Access to some updates might require product entitlement when accessed
through the Hewlett Packard Enterprise Support Center. You must have an HP Passport
set up with relevant entitlements.

Websites

LinkWebsite

www.hpe.com/info/enterprise/docsHewlett Packard Enterprise Information Library

www.hpe.com/support/hpescHewlett Packard Enterprise Support Center
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LinkWebsite

www.hpe.com/assistanceContact Hewlett Packard Enterprise Worldwide

www.hpe.com/support/e-updatesSubscription Service/Support Alerts

www.hpe.com/support/softwaredepotSoftware Depot

www.hpe.com/support/selfrepairCustomer Self Repair

http://www.hpe.com/info/nonstop-ldocsManuals for L-series

http://www.hpe.com/info/nonstop-jdocsManuals for J-series

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product.
If a CSR part needs to be replaced, it will be shipped directly to you so that you can install it at
your convenience. Some parts do not qualify for CSR. Your Hewlett Packard Enterprise authorized
service provider will determine whether a repair can be accomplished by CSR.
For more information about CSR, contact your local service provider or go to the CSR website:
www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support
agreement. It provides intelligent event diagnosis, and automatic, secure submission of hardware
event notifications to Hewlett Packard Enterprise, which will initiate a fast and accurate resolution
based on your product’s service level. Hewlett Packard Enterprise strongly recommends that
you register your device for remote support.
For more information and device support details, go to the following website:
www.hpe.com/info/insightremotesupport/docs

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To
help us improve the documentation, send any errors, suggestions, or comments to Documentation
Feedback (docsfeedback@hpe.com). When submitting your feedback, include the document
title, part number, edition, and publication date located on the front cover of the document. For
online help content, include the product name, product version, help edition, and publication date
located on the legal notices page.
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A Using the SQL Whiteboard
This appendix discusses the following topics:
• “Introduction to the SQL Whiteboard” (page 145)
• “Viewing the SQL Whiteboard” (page 145)
• “SQL Whiteboard panes” (page 145)
• “Statement List pane” (page 146)
• “Statement pane” (page 146)
• “Statement Details pane” (page 149)
• “Reusing a connection ” (page 150)
• “Loading and saving SQL statements to a file” (page 150)
• “Highlighting the SQL syntax” (page 150)
• “Managing the layout of panes” (page 150)

Introduction to the SQL Whiteboard
The SQL Whiteboard enables you to enter and execute SQL statements using MXDM, and
provides execution information for each of the SQL statements.
The list of SQL statements of one MXDM session persists in other MXDM sessions. Currently,
MXDM supports only one instance of the SQL Whiteboard.
You can specify SQL statements with parameters by enclosing parameter names within a double
dollar sign ($$). When the statement is executed, the SQL Whiteboard obtains values for the
parameters in the statement. You can reuse recently used values for those parameters.
Related Topics
“Viewing the SQL Whiteboard” (page 145)
“Saving and importing system definitions” (page 43)

Viewing the SQL Whiteboard
To view the SQL Whiteboard, use one of the following methods:

• On the MXDM toolbar, click SQL Whiteboard ( ).
• Select Tools→SQL Whiteboard.
Related Topics
“SQL Whiteboard panes” (page 145)
“Using the MXDM toolbar” (page 30)

SQL Whiteboard panes
Table 32 (page 145) describes the panes in the SQL Whiteboard.

Table 32 SQL Whiteboard panes

DescriptionPane

Displays a list of the SQL statements that you added using the Statement pane.Statement List

Enables you to enter any DML or DDL statement, including SELECT, INSERT, UPDATE,
DELETE, CREATE, ALTER, GRANT, DROP, REVOKE, and so on.

Statement

Displays detailed information about the execution results.Statement Details

Figure 53 (page 146) shows the SQL Whiteboard.
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Figure 53 SQL Whiteboard

Related Topics
“Statement List pane” (page 146)
“Statement pane” (page 146)
“Statement Details pane” (page 149)

Statement List pane
The Statement List pane provides a list of SQL statements that you added in the current session
or earlier sessions of the SQL Whiteboard tool. The list of SQL statements in one MXDM session
persists in other MXDM sessions similar to how connection information and favorites persist.
From the Statement List pane, you can perform the following tasks:
• View the name and statement that was previously added in the Statement pane. Optionally,

you can explicitly add a statement to the statement list without executing it.
• Update an existing statement in the list.
• Execute a statement.
• Sort the statements based on the statement name or statement text.
Table 33 (page 146) describes the options at the top of the Statement List pane. These options
enable you to select the statements that you want to execute.

Table 33 Statement List pane options

FunctionButton

Selects all statements in the Statement List pane.All

Clears all statements in the Statement List pane.None

Removes the results only or the selected statements and the results. You cannot remove
statements alone.

Discard

NOTE: You cannot discard a statement or the results while the statement is executing.
If a currently executing statement is part of a Discard selection, it is omitted.
Use Discard when you want to free virtual memory or when MXDM indicates that system
resources are running low. Until you exit the SQL Whiteboard, the result of every executed
statement is cached. If you have already executed several large statements in the current
session, the results are cached in memory. Therefore, less memory is available for new
executions. “Page mode” (page 148) describes how the SQL Whiteboard caches and displays
large result sets.

Statement pane
The Statement pane enables you to enter any SQL command (DDL or DML) in the text field.
The maximum number of characters you can enter in the text field is 2,147,483,647.
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Table 34 (page 147) describes the fields that define a statement in the Statement pane.

Table 34 Statement pane fields

FunctionField name

Enables you to enter the name of the SQL statement. You can specify a name to identify
the statement in the statement list.

Name

Enables you to select a system from the System menu on which you want to execute the
query.

System

Enables you to enter the maximum rows that you want returned and displayed in the
Statement Details pane. The default is 500 rows and the maximum is 2,147,483,647.

Max Rows

Enables you to select a schema name from the Schemamenu. If you do not explicitly qualify
the query by specifying a three-part ANSI name, the default schema is the currently selected
value in the menu.

Schema

Enables you to enter the number of rows to be retrieved and displayed in one page of the
statement result set. You can set a value between 1 and 100,000. Or, use the default
Rows/Page value (0), which causes MXDM to retrieve and display the entire result set.

Rows/Page

If you specify a value of 1 or more, or if you use the default setting and MXDM cannot retrieve
and cache the entire result set using available memory, MXDM automatically displays the
result set in pages. For more information on page mode, see “Page mode” (page 148).

Table 35 (page 147) describes the options at the bottom of the Statement pane that enable you
to test and modify the statement.

Table 35 Statement pane buttons

FunctionButton

Enables you to add a new SQL statement or duplicate a statement to the Statement
list.

Add

Enables you to update the statement. Modify the required information, and clickUpdate.Update

Executes the statement and displays the results in the Statement Details pane.Execute

Terms
page mode

Parameter prompts
SQL statements can contain parameter names enclosed within $$ (double dollar signs). When
you execute the statement, the SQL Whiteboard prompts you for values for all parameters in
that statement. You can reuse values for those parameters.
For example, consider a table, T that contains a column T1. You can enter the following statement
in the Statement field:
Select T1 from T where T1 = $$p1$$

When you click Execute, the Parameters dialog appears.
Enter a value, for example 1. The statement is executed, and the following tabs will appear in
Statement Details dialog:
• Execution Results — Displays the output generated by the statement after the parameter

is replaced by the value you entered.
• Execution Parameters — Lists p1 parameter with value 1.
• Executed Statement — Contains Select t1 from T where t1 = 1.
You can enter another statement that uses the parameter, p1. The statement will be executed.
For example, if you enter Select * from T where T1 = $$p1$$ + $$p2$$, the same
dialog appears. However, p1 (with value one) and p2 appear.
You can enter values again.
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Page mode
When you execute a statement in the SQL Whiteboard, MXDM caches the results in virtual
memory. The SQL Whiteboard displays these results, but the virtual memory allotted for the SQL
Whiteboard can exhaust in the following scenarios:
• A single query has a large result set consisting of a large number of columns or a large

number of rows, or both.
• Several queries with large result sets are executed in a single SQL Whiteboard session.
To prevent an out-of-memory condition and accommodate large result sets, the SQL Whiteboard
can run in the page mode. In the page mode, the SQL Whiteboard breaks large result sets into
pages and retrieves one page at a time instead of retrieving all the data and displaying all rows
in the grid. The page mode reduces the memory usage because only a partial result is held in
memory and displayed in the Statement Details pane.

Default page mode operation
By default, the SQL Whiteboard displays all the results of a statement. However, it automatically
runs in page mode in the following scenarios:
• Insufficient memory is available to display the result set in one page.
• You specify a value from 1 to 100,000 in the Rows/Page field of the Statement pane. In

this case, if sufficient memory is available, the SQL Whiteboard automatically uses page
mode and allocates the number of rows per page that you specified.

Page mode considerations
The following considerations apply for page mode:
• During the course of statement execution, MXDM frequently computes the available virtual

memory of the application. If the available virtual memory is less than an internal threshold,
statement execution happens in the page mode. You cannot modify this behavior. In some
cases, you must use the page mode to prevent MXDM from running out of memory and
generating an exception.

• When a statement is executed and the number of rows is less than theRows/Page threshold,
all rows in the results are retrieved and displayed in the grid.

• When a statement is executed and the number of rows in the result set exceeds the
Rows/Page threshold, statement execution happens in the page mode. Partial results are
retrieved and displayed.

• When statement execution happens in the page mode, the Statement Details pane displays
Next Page. The following considerations apply:

◦ Until you click Next Page, the execution is paused, and the SQL cursor remains open.
However, the Time Elapsed timer continues to run because it tracks the wait time.

◦ When you click Next Page, the next page of results is retrieved from the server. The
first page is deleted from the grid when the new page is loaded. The process repeats
until you either view all the pages or cancel the query.

◦ You cannot return to the previous page because the ODBC cursor operates in the
FORWARD mode only. To display earlier results, you must re-execute the statement.

• Regardless of whether the number of rows in the result set exceeds theRows/Page threshold,
if the available virtual memory falls below the internal threshold, the statement execution
goes into the page mode and displays the results that have been retrieved so far. In this
case, the grid might display fewer rows than the Rows/Page threshold. This situation
continues until garbage collection begins, and the memory occupied by the pages that have
been disposed becomes available again. When the system resources are low, theStatement
Details pane displays a message that execution is in the entering page mode.

• Grid sorting works only on the currently displayed page.
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• In the page mode, the following options copy data for the current page only:

Data to Clipboard◦
◦ Data to Browser

◦ Data to Spreadsheet

◦ Data to File

• To free workstation memory, you can discard the results of the selected statement(s) cached
in the Statement List pane. For more information, see “Statement List pane” (page 146).

Executing SQL queries
If you highlight text, you can execute a part of a statement.
If you highlight text in the Statement pane, and click Execute, the query formed by that text is
executed. For example, if the Statement pane contains the query, select * from t, where
t1 = 1, and if you highlight the part select * from t and click Execute, select * from
t is executed.

Cancelling a query from the SQL Whiteboard
You can cancel a running query if the query is wrong, the query is inefficient, or if the query is
creating a performance issue and needs to be stopped.
After a query starts executing, the SQL Whiteboard Execute button changes to Cancel. Clicking
Cancel terminates the SQL query.

Statement Details pane
The Statement Details pane contains statistics and details generated from the selected statement
in the Statement List pane. You can use these details for reference only. The pane has no
interactive functionality. Statistics appear only for statements that are loaded from the Statement
pane.
Table 36 (page 149) describes the fields that appear in the Execution Results tab when a
statement executes successfully.

Table 36 Execution Results fields

FunctionField or button

Indicates when the statement was last evaluated.Last Evaluated

Indicates the time taken to execute the query.Query Execution Time

Displays the executed statement status. The status indicates whether the statement was
executed successfully or whether the statement was canceled.

Status

Displays the next set of execution results when the statement execution happens in the
page mode. For more information on the page mode, see “Page mode” (page 148).

Next Page

For DML statements such as INSERT, DELETE, and UPDATE, the results indicate how many
rows were affected if the execution is successful. For other SQL commands, the results appear
in text form.
For SELECT statements, you can use the Copy options to copy the results to a file, clipboard,
or a spreadsheet. The copy options are Data to Clipboard, Data to Browser, Data to
Spreadsheet, and Data to File. The data is preserved only while the SQL Whiteboard remains
open. The data is flushed when the SQL Whiteboard is closed. Also, when in the page mode,
you can copy data in the current page only.
Table 37 (page 150) describes the tabs.
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Table 37 Statement Details tabs

FunctionTab

Displays the statement execution error.Execution Error

Displays values set for the current or earlier execution. The Execution Parameters
tab is displayed only if the statement has parameters.

Execution Parameters

Displays the statement that was executed with the parameters (if any), replaced with
their values.

Executed Statement

For more information on the page mode, see “Page mode” (page 148).
Related Topic
“Copying data” (page 42)
Term
page mode

Reusing a connection
The reuse connection feature is enabled by default in the SQL Whiteboard. As a result, all queries
executed for the selected system use the same connection. This system appears in theStatement
Pane, under System. To close the connection, right-click the system icon in the left pane and
select Disconnect. As a result, if the SQL Whiteboard is using the same connection, it stops.
Hewlett Packard Enterprise recommends that you disconnect the system to release system
resources.

Loading and saving SQL statements to a file
The SQL Whiteboard provides commands that enable you to import an SQL statement from a
text file to the Statement pane. You can also copy SQL statements from the Statement pane
to a specified text file.
Table 38 (page 150) describes the commands in the File menu that you can use to import and
copy SQL statements.

Table 38 File menu options

FunctionMenu item

Loads the text of an SQL statement from an ASCII file to the Statement field.Load SQL Statement

Saves the current SQL statement text from the Statement field to an ASCII file. This
command saves only the statement text, but not the statement results. To save the
results, use theData to Clipboard,Data To Spreadsheet, or theData to File options.

Save SQL Statement

Related Topic
“Copying data” (page 42)

Highlighting the SQL syntax
To highlight the SQL syntax in the Statement pane, select Format→Highlight Syntax. The SQL
keywords in the SQL text are highlighted.

Managing the layout of panes
The SQL Whiteboard enables you to move and resize individual panes. After setting the layout,
select File→Lock Layout to lock the layout. Subsequently, you cannot move or resize the
Statement, Statement List, and Statement Detail panes. To unlock the layout, select
File→Unlock Layout.
To reset the layout to the default configuration, select File→Reset Layout.
To ensure that the layout persists across SQL Whiteboard or MXDM invocations, select File→Save
Persistence. Subsequently, when you launch the SQL Whiteboard either in the current instance
of MXDM or in a restarted MXDM instance, the layout is restored.
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NOTE: The Export Persistence option in the File menu, in the SQL Whiteboard and the
Export Persistence option in the main window have the same effect.

Related Topic
“Saving and importing system definitions” (page 43)
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Glossary
area A broad category of features that you can manage or monitor using MXDM. See “Selecting an

area” (page 30).
association
server

The logical component that starts up and manages MXCS SQL servers and associates a client
connection request with a specific MXCS SQL server in a data source. See also “Displaying
MXCS Services” (page 123).

connection When a user interaction requires interaction with a system, the relevant code uses the system
definition for that system to transparently establish one or more ODBC connections, as needed.

data grid A tabular presentation of system data. MXDM data grids provide special features for displaying
and manipulating data. The SQL Whiteboard Statement Details pane display information in
a data grid. Tabs in the Database area do not provide data-grid features. For more information
about data-grid features, see “Introduction to data grids” (page 39).

data source A logical name that defines the information required to access data. On the client side, the data
source defines the driver name, network address, and specific attributes, such as the catalog
and schema names. On the server side, it defines startup values, the number of servers in a
pool, DEFINEs, SQL/MX control statements, and resource management policies.

disconnect Because connections are transient, there is no concept of logging on or logging off. The MXDM
equivalent of logon is making a system usable by entering the correct settings. The MXDM
equivalent of logoff is making a system unusable by disconnecting (or invalidating any of its
other settings). Use the Disconnect function when you want the client application to continue
running, but you want to deny continued access to a system without having to remove the
system definition. See “Disconnecting from a system” (page 20).

favorite A favorite is a shortcut to an object on the navigation tree pane. Favorites appear in the My
Favorites pane. Clicking a favorite enables you to navigate quickly to any object on the tree
pane that might otherwise require scrolling through and expanding numerous parent objects.
MXDM enables you to create favorites and organize them in folders.

MACL SQL/MX Administrative Command Library
menu bar The menu bar is the list of commands at the top of the MXDM main window. The menu bar

commands are: File, Edit, Tools, Windows, and Help. “MXDM interface” (page 26) shows the
menu bar.

MXCS (SQL/MX
Database
Connectivity
Service)

The server component that enables connectivity from client applications to the SQL/MX database.
The SQL/MX Database Connectivity Service consists of an Association server (MXOAS), a
configuration server (MXOCFG), and MXCS SQL servers.

MXCS server A process that manages an ODBC connection.
MXCS Service A process that uses data sources to launch MXCS SQL servers to manage connections.
MXDM HPE NonStop SQL/MX Database Manager (MXDM) is an integrated graphical user interface

(GUI) client that enables you to connect to and manage multiple NonStop SQL/MX databases.
MXOAS MXOAS is the component of the SQL/MX Database Connectivity Service (MXCS) that receives

client connection requests for database access and associates the requestor with a server to
execute the requested access. See “Displaying MXCS Services” (page 123).

My Systems In the navigation tree pane, a folder showing the group of SQL/MX platforms that are currently
defined in the Systems Tool. The icon for each system shows the connection status for that
system. For more information, see “Using the navigation tree” (page 32).

navigation tree
pane

The left pane of the NonStop SQL/MX Database Manager interface that displays a tree of the
database objects in a hierarchical form. “MXDM interface” (page 26) shows the navigation tree
pane.

operator
permission

An MXCS permission that allows a user to perform administrative tasks, such as managing
data source configurations, MXCS services, data sources, and servers, by making changes to
status and configuration. For more information, see “Displaying MXCS user permissions” (page
137) or “Adding an MXCS user” (page 138).
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page mode A SQL Whiteboard feature that breaks large result sets into pages and fetches one page at a
time. To prevent out-of-memory conditions, page mode limits the amount of memory used by
the SQL Whiteboard. In page mode, only a partial result of a query is held in memory and
displayed in the Statement Details page. For more information, see “Page mode” (page 148).

persistence file A binary file that contains state and user preference information (for example, system definitions,
user-specified options, favorites, and layout information). For more information, see “Saving
and importing system definitions” (page 43).

query A request for data from the database; specifically, the execution of a SQL statement, which
requests columns and rows from one or more tables and views. In the context of the SQL/MX
optimizer, a query is a request for data access through an DML statement.

right pane The right pane of the NonStop SQL/MX Database Manager interface displays information about
the selected objects in the navigation tree pane. “MXDM interface” (page 26).

segment A subdivision of a SQL/MX cluster that consists of 16 processing nodes (CPUs). Each segment
has a name (for example, HPQ0101), and the SQL/MX cluster contains one master segment.
All other segments are considered slave segments.

SQL statement Any DML or DDL statement including, but not limited to SELECT, INSERT, UPDATE, DELETE,
CREATE, ALTER, DROP, GRANT, and REVOKE. For more information about SQL statements,
see HPE NonStop SQL/MX Release 3.4 Reference Manual.

SQL Whiteboard A utility that allows you to enter and execute SQL statements from within MXDM. For more
information, see “Introduction to the SQL Whiteboard” (page 145).

system The user view of a system definition.
systemdefinition A user-named set of all of the information required to construct an ODBC connection string:

server data source, username, password, server IP address or DNS name, port number, default
schema, and ODBC driver version. The banner displays the system definition. See “MXDM
banner” (page 27).

system monitor The system monitor is a tool within MXDM that displays status and performance data for the
SQL/MX platform. The displayed status and performance data includes seven performance
metrics and four system status icons.

Systems Tool The tool used to define, add, edit, remove, duplicate, test, and open a connection with a SQL/MX
platform. The Systems Tool is available from the Tools menu.

TDM_Default_
DataSource

The default data source for SQL/MX platform. TDM_Default_DataSource is the default data
source for database access. You cannot delete TDM_Default_DataSource, but you can configure
other data sources.

user permission MXCS permission that allows you to view data source configurations, MXCS services, MXCS
servers, and data sources. See also “Displaying MXCS user permissions” (page 137).
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Index

A
About

box, MXDM, 37
command, Help menu, 29

accessing
updates, 143

Add DEFINE dialog box, 131
Add SET dialog box, 131
Admin_Load_DataSource

stopping service for, 125
Alerts

data grid, customizing, 40
Application Name, MXCS Server, 122
Apply button

Configuration tab, 136
Data Source Status tab, 137

Area
connectivity, 31
database, 31
defined, 152
selecting, 30
showing and hiding, 31

Association servers
defined, 152

Available
Data Source Status, 127
Data Sources, 126

B
Banner

example, 27
location, 26

Build information
MXDM client, 37

C
Check box (green), 32
Client/server compatibility, 14
Clone in Window, 35
Close All Windows Except Main Window, 29
Closing MXDM, 25
Columns

customizing, 40
sorting and moving, 37

Compatibility with older servers, 14
Computer Name, MXCS Server, 122
Connect / Edit System

toolbar button, 30
Connected, Data Source Status, 127
Connecting (see also Disconnecting)

defined, 152
connecting (see also disconnecting)

connecting to a system, 19
Connection

Idle Timeout, 129
information, 129

reusing, 150
timeout, 23

contacting Hewlett Packard Enterprise, 143
Contents command, Help menu, 29
Control Query Defaults tab, 132
Control Table Statements tab, 133
Copy command, 40

Edit menu, 28
toolbar button, 30

Copying data
data to clipboard, 42

copying data
data to browser, 43
data to file, 42
data to spreadsheet, 42

Count, Data Source Status, 127
CQDs, adding or modifying, 132
Create New Data Source Like, 134
customer self repair, 144
Cut command

Edit menu, 28
toolbar button, 30

D
Data columns, sorting and moving, 37
Data grid

Copy command, 40
customizing, 40
defined, 152
description of, 39
row details, 39
searching, 41

Data Source
defined, 152
name, 128
performance, 129
updating, 136

Data source
copying, 134
creating, 127
deleting, 136
displaying, 125
starting up, 135
Status tab, 125
stopping, 135

Data Source Name
Data Source Status, 127
Data Sources, 126
MXCS Server, 122

Data Sources tab, 125
Data to Browser, 43
Data to Clipboard, 42
Data to File, 42
Data to Spreadsheet, 42
Data, copying, 42
Database

area, 30
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DEFINEs and SETs tab, 130
Delimited identifiers, 128
Disconnecting

toolbar button, 30
Disconnecting (see also Connecting)

defined, 152
disconnecting (see also connecting)

function, 20
documentation

providing feedback on, 144
Documents, related information, 8

E
Edit DEFINE dialog box, 131
Edit menu options, 28
Edit SET dialog box, 131
Editing a system, 22
Error

messages, 37
Exit command, 28
Exiting MXDM, 25
Export Persistence command, 28

F
Favorite

considerations, 32
creating, 32
creating a folder for, 31
defined, 152
Displaying, 32
removing, 32
using, 31

Features, new in MXDM, 7
File menu options, 28

G
General properties tab, 128
Glossary, 152
Go to Next toolbar button, 30
Go to Parent toolbar button, 30
Go to Previous toolbar button, 30

H
Help

menu options, 29
toolbar button, 30

HP NonStop SQL/MX Remote Conversational Interface
(RMXCI)
toolbar button, 30

HPE NonStop SQL/MX Remote Conversational Interface
(RMXCI)
auto logon options, 142
locating, 141

I
Import Persistence

menu command, 28
toolbar button, 30

Index command, Help menu, 29

Information, new and changed, 7

L
Last State Changed, Data Source Status, 127
Last Updated Time

MXCS Server, 122
MXCS Services, 124

Load SQL Statement command, 150
Lock command, 150

M
Max Rows, SQL Whiteboard, 147
Maximum

Data Source Status, 127
Data Sources, 126

Menu bar
commands, 28
defined, 152

Monitoring area, 30
Multicolumn sorting, 38
MXCS server

defined, 152
displaying all, 121
status tab, 121
stopping, 122

MXCS service
defined, 152
displaying, 123
starting up, 124
stopping, 125

MXCS Services, 128
MXCS Services tab, 123
MXCS user

adding, 138
deleting, 139
Displaying, 137
editing, 139

MXCS, defined, 152
MXDM

database-object browsing, 11
exiting, 25
features, 11
framework, 12
SQL Whiteboard, 12
uninstalling, 16

MXDM graphical user interface (GUI), 26
MXOAS

defined, 152
My Favorites pane, 31
My Systems, 152

navigation tree pane folder, 32
result of connecting, 19
right-clicking, 17

N
Name, SQL Whiteboard, 147
NameInstalling MXDM

uninstalling MXDM, 128
Navigation Tree Pane
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overview, 32
Navigation tree pane

defined, 152
New and changed information, 7
New features, MXDM, 7
Next Page button

description of, 149
Statement Details pane, 148

Node
MXCS Services, 124
order, 130
utilization, 130

NonStop SQL/MX Remote Conversational Interface
(RMXCI)
command, Tools menu, 29
launching, 141
learning about, 141

Number of servers, 129

O
ODBC

connection, testing, 23
Operator permission

defined, 152
Options

command, Tools menu, 29
general, 31
HP NonStop SQL/MX Remote Conversational Interface

(RMXCI), 142
show/hide area, 31
toolbar button, 30

Out-of-memory exceptions, 148

P
Page mode

defined, 153
understanding, 148

Panes
expanding and collapsing, 36
working with, 35

Parameters
SQL Whiteboard statement, 147

Password
not specified, 21

Paste command
Edit menu, 28
toolbar button, 30

Persistence file
defined, 153
saving and updating, 43

PID Client, MXCS Server, 122
Port

MXCS Server, 122
MXCS Services, 124

Process Name
MXCS Server, 122
MXCS Services, 124

Process priority, 129
Publishing history, 10

Q
Query

canceling from SQL Whiteboard, 149
defined, 153

R
Redo command

Edit menu, 28
Release compatibility, 14
Releases

supported, 14
remote support, 144
Reset Layout command, 150
Resource management

adding or modifying policies, 130
for data sources, 130

Right pane
defined, 153
using, 34

RMXCI (see also NonStop SQL/MX Remote
Conversational Interface (RMXCI), 141

Row details
getting, 39

Rows/Page
effect of, 148
field, 147
SQL Whiteboard, 147

S
Save Persistence

menu command, 28
toolbar button, 30

Save SQL Statement command, 150
Schema, default

SQL Whiteboard, 147
Search command, Help menu, 29
searching

database object, 45
Segment

defined, 153
Select All command

Edit menu, 28
Server idle timeout, 129
Server PIN

MXCS Server, 122
MXCS Services, 124

Server traces, 137
Service Name

Data Source Status, 127
MXCS Server, 122
MXCS Services, 124

Service Type, MXCS Services, 124
Session statistics, 129
Session summary, 129
SET variables, 131
Shortcut

favorite, defined, 152
navigational, 31

Show/Hide Area Options, 31
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Show/Hide Grid Columns, 41
Sorting data, 37
Special characters, 128
SQL statement

defined, 153
loading into SQL Whiteboard, 150
saving to ASCII file, 150
statistics, 130

SQL Whiteboard
canceling an SQL query, 149
command, 29
defined, 153
displaying, 145
executing hightlighted test, 149
highlighting syntax, 150
loading and saving SQL statements, 150
managing layout, 150
overview, 145
parameter prompt, 147
reusing a connection, 150
statement details pane, 149
statement list, 146
statement pane, 146
toolbar button, 30

SQL/MX Database Manager
parts of, 26

SQL/MX Messages Manual, 37
Start Ahead

Data Source Status, 127
Data Sources, 126

Start Mode, 129
State

Data Source Status, 127
MXCS Server, 122
MXCS Services, 124

Statement Details pane, SQL Whiteboard, 149
Statement List pane, 146
Statement pane, 146
Statement statistics, 130
Status Bar, location of, 26
Stop Immediately, 125, 136
Stop on Client Disconnect, 136
support

Hewlett Packard Enterprise, 143
System

add like, 22
adding, 17
connecting to, 19
defined, 153
disconnecting from, 20
editing, 22
field, Statement Pane, 147
removing, 23
testing, 23

System definition
banner display of, 27
defined, 153
saving or importing, 43

System monitor

definition, 153
Systems Tool

command, Tools menu, 29
defined, 153
options, 21
overview, 20
toolbar button, 30
using, 20

T
table

granting privileges, 77
revoking privileges, 79

Tabs
cloning, 35
working with, 35

TDM_Default_DataSource
defined, 153
deleting, 136

Test command, 23
Timeout

setting the connection, 23
Toolbar

MXDM, 30
Tools menu options, 29
Tooltips, 128
Tracing

Data Source Status tab, 127

U
Undo command

Edit menu, 28
Uninstalling MXDM, 16
updates

accessing, 143
User Name

MXCS Server, 122
User permission

adding, 138
defined, 153
deleting, 139
Displaying, 137
editing, 139

V
Version information, MXDM client, 37

W
websites, 143

customer self repair, 144
Windows

cloning, 35
menu options, 29
working with, 35

Windows Manager
menu option, 29
toolbar button, 30
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